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INTRODUCTION

This appendix provides a concise guide to using Microsoft Office Project Standard
2003 (often referred to as Project Standard 2003 or, simply, Project 2003) to
assist in performing project management. Project 2003 can help users manage
different aspects of all nine project management knowledge areas. Most users,
however, focus on using Project 2003 to assist with scope, time, cost, human
resource, and communications management. This guide uses these project man-
agement knowledge areas as the context for learning how to use Project 2003.
Refer to chapters on the other knowledge areas for suggestions on using software
to assist in those areas. Also, note the basic order of the steps in this appendix. It
is good practice to first determine the scope of a project, then the time, and then
the resource and cost information. You can then set a baseline and enter actuals
to track and communicate performance.

Hundreds of project management software products are available today.
Microsoft Project is the clear market leader among midrange applications. A 2003
survey by TechRepublic showed that 94 percent of their 397 respondents used
Microsoft Project compared to 86 percent of respondents in their 2000 study.1

Before you can use Project 2003 or any project management software
effectively, you must understand the fundamental concepts of project manage-
ment, such as creating work breakdown structures, linking tasks, entering
duration estimates, and so on. See the Suggested Readings for recommenda-
tions on other resources to help you gain an even deeper understanding of
Project 2003.

1 Blakely, Beth. “Survey shows little change in consultants’ use, satisfaction with PM software,”
TechRepublic, 2/3/03 (http://techrepublic.com.com/5100-6330_11-5031832.html).
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NEW FEATURES OF PROJECT 2003

Because there have been several previous versions of Microsoft Project, it is
useful to understand some of the new capabilities of Project 2003, especially if
you are working with people who are upgrading from a previous version. 

With the introduction of Project 2002, Microsoft provided two versions of
Project—a standard version and an enterprise version. The same is true for
Project 2003. 

1. Microsoft Office Project Standard 2003, or simply Project 2003, is
most similar to previous versions of Microsoft Project and is intended
for individual desktop usage. Project 2002 Standard included a Client
Access License (CAL) for connection to Project Server 2002 via the
Web, but Project Standard 2003 does not. You must be using Project
Professional 2003 to connect to Project Server 2003, as described
below. Also note that Project 2002 can open, work with, and save
Project 2003 files, so you don’t have to save files in Project 2002 for-
mat from Project 2003. This appendix focuses on using the standard
version of Project 2003. 

2. The Microsoft Enterprise Project Management (EPM) Solution is a
complete database and analysis software package that helps organizations
plan and manage projects on an enterprise level. It includes several com-
ponents, such as Microsoft Office Project Professional 2003 (which
includes all of the capabilities of Project Standard 2003 plus more fea-
tures), Project Web Access, Project Server 2003, Microsoft Windows
SharePoint Services, and Microsoft SQL Server. Project Web Access is the
Web portal to Project Server 2003 that provides an easy-to-use interface
with a customized home page and functions that are based on each user’s
role on the project. Project Web Access users do not have to install Project
Professional 2003; they just need a Client Access License (CAL) and a
Web browser. Organizations should develop and apply many standards,
templates, codes, and procedures before using the enterprise version of
Project 2003 to make the best use of its capabilities. In fact, Microsoft pro-
vides a template file for implementing their EPM solution, and the sched-
ule goal in the template file is about six months. 

Figures A-1, A-2, and A-3 provide sample screens from the Microsoft EPM
Solution taken from an online tour available from Microsoft’s Web site.
Figure A-1 shows the customized home page that an executive would see
when using his or her Client Access License. Figure A-2 shows an executive
summary view of all of the projects at this company. Figure A-3 shows a sam-
ple screen available from the portfolio analyzer. The reporting and analysis
capabilities in the EPM solution help organizations use information from
many projects and team members to optimize resources, prioritize work, and
align project portfolios with overall business objectives. For more information

Information Technology Project Management, Fourth Edition
Kathy Schwalbe

Copyright 2006 Thomson Course Technology. All rights reserved.

DO N
OT 

COPY



on the Microsoft Office EPM Solution, contact Microsoft or visit their Web site
at www.microsoft.com/project.

Figure A-1. Sample Project Web Access Home Page

Figure A-2. Sample Project Web Access Project Center Screen
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Figure A-3. Sample Project Web Access Portfolio Analyzer Screen

Figure A-4 provides an overview of using either Microsoft Office Project
Standard 2003 (Project 2003) or the Microsoft Office EPM Solution. Remember
that Project 2003 is a stand-alone product that enables users to plan and man-
age projects with familiar, easy-to-use tools. Project Professional 2003, Project
Web Access, Project Server 2003, and Microsoft SQL Server work together to
make up the Microsoft Office EPM Solution, which should have many users.

Information Technology Project Management, Fourth Edition
Kathy Schwalbe

Copyright 2006 Thomson Course Technology. All rights reserved.

DO N
OT 

COPY



Figure A-4. Microsoft Office Project Standard 2003 Versus Microsoft Enterprise
Project Management (EPM) Solution

There are also several new and improved features available in Project 2003:

■ New ability to manage proposed and committed resources

■ New shared workspace for storing non-Project files (including check-in
and versioning)

■ Backward and forward compatibility so users of previous and future ver-
sions of Project can easily share files

■ New features for sharing data between Project and Excel, PowerPoint, and
Visio, including the new Copy Picture to Office Wizard

■ New online Help for up-to-date information and assistance via the Web

■ New Euro currency converter toolbar

Microsoft SQL Server

Microsoft Office Project Standard 2003

Microsoft Enterprise Project Management (EPM) Solution

Project
Server 2003

Project Web
Access

Project
Professional

2003

Server software, central location
for project-related information

Required for enterprise project
management functionality

Project
Standard 2003

Desktop application
For individual business and project managers
Most similar to previous versions of Project

Project team members and
executives use Client Access
Licenses to access information

Project managers use
on their desktops,
provides full functionality
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■ Improved ability to create one-page printouts of project plans easily

■ New calendar and tracking setup wizards

■ Improved Project Guide, which is an interactive Help tool

■ No more requirement that a developer hard-code paths for files used in
customizing the Project Guide

■ Enhanced developer tools for integration with Microsoft Office

BEFORE YOU BEGIN

This appendix assumes you are using Project 2003 with Windows 2000 or XP
and are familiar with other Windows-based applications. You can check your
work using the solution files that are available for download from the compan-
ion Web site for this text (www.course.com/mis/schwalbe4e) or from your instructor. 

The CD-ROM in the back of this text includes a 120-day trial version of
Project 2003. You need to be running Windows 2000 or Windows XP to use
this software. If you have any technical difficulties, contact Course
Technology’s Support Services at www.course.com/support. You can also down-
load or order evaluation copies of Project 2003 from www.microsoft.com/project.
Also note that students and faculty can purchase software at deep discounts
from several sources, such as www.journeyed.com. 

This appendix uses a fictitious information technology project—the Project
Tracking Database project—to illustrate how to use the software. The goal of
this project is to create a database to keep track of all the projects a company is
working on. Each section of the appendix includes hands-on activities through
which you will work. To complete the hands-on activities in the appendix, you
will need to create a Data Disk or copy files to a location on your hard drive or
network drive. You will need to copy a set of files from a file server or from the
companion Web site for this text (www.course.com/mis/schwalbe4e). When you
begin each set of steps, make sure you are using the correct file from your Data
Disk, hard drive, or network drive. You should have the following files before
you begin your work: 

■ PRJ03DPL.mpp, the Project 2003 Deployment template file that comes
with the software

■ resource.mpp

■ tracking.mpp

■ kickoffmeeting.doc

In addition, you will create the following files from scratch as you work
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through the steps: 

■ scope.mpp

■ time.mpp

■ tracking.mpp

■ baseline.mpp

■ level.mpp 

■ taskinfo.html

Now that you understand project management concepts and the basic proj-
ect management terminology, you will learn how to start Project 2003, review
the Help facility and a template file, and begin to plan the Project Tracking
Database project. 

OVERVIEW OF PROJECT 2003

The first step to mastering Project 2003 is to become familiar with the Help
facility, online tutorials, major screen elements, views, and filters. This section
describes each of these features.

Starting Project 2003 and Using the Getting Started and
Project Guide Features

To start Project 2003:

1. Open Project 2003. Click the Start button on the taskbar, click
Programs, and then click Microsoft Office Project 2003. (If you
are using Windows XP, point to All Programs, point to Microsoft
Office, and then click Microsoft Office Project 2003.)
Alternatively, a shortcut or icon might be available on the desktop; in
this case, double-click the icon to start the software.

2. Maximize Project 2003. If the Project 2003 window does not fill the
entire screen as shown in Figure A-5, click the Maximize button 
in the upper-right corner of the window.

A.8 A P P E N D I X  A
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Figure A-5. Getting Started Task Pane and Project 2003 Main Screen

If the View Bar is not open, click View on the menu bar, and then
click View Bar. 

Do not worry if your toolbars or other screen elements look
slightly different from Figure A-5. Focus on the Project 2003
main screen and the Getting Started task pane. 

Project 2003 is now running and ready to use. Notice some of the elements
of the Project 2003 screen. The default view is the Gantt Chart view, which
shows tasks and other information in the Entry table as well as a calendar dis-
play. You can access other views by clicking each button in the View Bar on the
left side of the screen. Also notice that when Project 2003 starts, it opens a new
file named Project1, as shown in the title bar. If you open a second file, the
name will be Project2, and so on, until you save and rename the file.

When you start Project 2003, the Getting Started task pane automatically
opens, as shown in Figure A-5. You can access Microsoft Office Online, search
for help on various topics, or open files from this pane. If you were used to see-
ing the Project Guide when starting Project 2002, you may notice that you
now access the new Project Guide from the Project Guide toolbar, as shown in

Help
?

Help
?

Getting Started
task pane

Main screen showing
Gantt chart view

View Bar

Search for:
Entry bar

Menu bar

Toolbar
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Figure A-6. The Project Guide helps you learn Project 2003 by providing
instructions for completing various steps in building a Project 2003 file.

To use the Project Guide:

1. Open the Project Guide. Click the Tasks list arrow on the Project Guide
toolbar, as shown in Figure A-6. Notice the various options listed. The
Resources, Track, and Report buttons on the Project Guide toolbar list
additional options. You’ll use some of these options later in this appendix.

Figure A-6. Using the Project Guide

2. Set the project start date. Click Define the project. 

3. Review the Project Guide instructions. Review the information that dis-
plays in the pane on the left side of the screen. As you select different
options in the Project Guide, the task pane displays specific informa-
tion related to that option. Notice that the default project start date is
set at the current date. Click the date list arrow on the pop-up calen-
dar to select a date. Select the last day of the month that displays.

4. Close the Project Guide. Click the Close button in the upper-right
corner of the Project Guide window, and then click Yes when
prompted to exit the wizard.

If the Project Guide toolbar is not visible, click View on the menu
bar, select Toolbars, and then click Project Guide. 

Help
?

Project
Guide
toolbar

A.10 A P P E N D I X  A

Information Technology Project Management, Fourth Edition
Kathy Schwalbe

Copyright 2006 Thomson Course Technology. All rights reserved.

DO N
OT 

COPY



G U I D E  T O  U S I N G  M I C R O S O F T  P R O J E C T  2 0 0 3 A.11

In addition to using the Project Guide window, you can access other infor-
mation to help you learn how to use Project 2003 under the Help menu.
Figure A-7 displays the Help menu options available, and Figure A-8 provides a
description of each option.

Figure A-7. Project 2003 Help Menu Options

Figure A-8. Descriptions of Project 2003 Help Menu Options

HELP MENU OPTION DESCRIPTION

Microsoft Project Help Displays a Search for: textbox for assistance,
the Table of Contents for Help, and options 
for using Microsoft Office Online.

Show the Office Assistant Acts as a toggle to display and hide the
Office Assistant, a context-sensitive, interactive
guide to finding information on Project 2003.

Microsoft Office Online Takes you directly to the Web site for
Microsoft Office Online.

Customer Feedback Option Provides information about Microsoft’s 
Customer Experience Improvement Program.

 This program allows Microsoft to collect 
anonymous information about your
hardware configuration and how you use 
their software and services to identify trends
and usage patterns.

Detect and Repair Automatically finds and fixes errors in all
Office files.

About Microsoft Office Project Displays the version of Microsoft Office Project,
licensed use, and other information about 
Project 2003.
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Microsoft realizes that Project 2003 can take some time to learn and pro-
vides a number of resources on its Web site. Select MS Office Online from the
Project 2003 Help menu to go to Microsoft’s Web site for Office products.
Microsoft’s Web site for Project 2003 (www.microsoft.com/project) provides files
for users to download, case studies, articles, and other useful materials.

Within Project 2003, the Office Assistant helps answer questions as they
arise. You can access the Office Assistant at any time by selecting Show the
Office Assistant from the Help menu. You can also press F1 or click the Office
Assistant button on the Standard toolbar. As in other Microsoft applications,
the Office Assistant allows you to type a question and search for related infor-
mation. You can hide the Office Assistant from the Help menu if you no
longer want it to appear on your screen. Feel free to experiment with the vari-
ous Help tools.

Main Screen Elements

The Project 2003 default main screen is called the Gantt Chart view. At the top
of the main screen, the menu bar and Standard toolbar are similar to those in
other Windows programs. Note that the order and appearance of buttons on
the Standard toolbar may vary, depending on the features you are using and
how the Standard toolbar is customized. When you use a button, it automati-
cally becomes visible on the toolbar it’s associated with. You can display the
Standard toolbar in one row or two, or you can set it to always show full
menus so that all buttons are visible all the time. Additional toolbars in Project
2003 include the Formatting toolbar, the Custom Forms toolbar, and the
Tracking toolbar, among others. 

To customize the Standard toolbar:

1. Open the Customize dialog box. Click Tools on the menu bar, select
Customize, and then click Toolbars to display the Customize dialog
box. Click the Options tab.

2. Show full menus. Click the option to Always show full menus, as
shown in Figure A-9, and then click the Close button to close the
dialog box.

A.12 A P P E N D I X  A
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Figure A-9. Customizing the Toolbar

3. If needed, add the Link Tasks button to the toolbar. Click the Toolbar
Options button on the toolbar , and then click the Link Tasks
button , as shown in Figure A-10. 

Figure A-10. Adding the Link Tasks Button to the Toolbar

Add or Remove Buttons

Toolbar Options

Link Tasks

Check the
toolbar options
you prefer, such
as always
showing full
menus
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4. If needed, add the Zoom In and Zoom Out buttons to the toolbar. Click the
Toolbar Options button on the toolbar again, and then click the
Zoom In button . Click the Toolbar Options button again, and
then click the Zoom Out button , as shown in Figure A-11.

Figure A-11. Adding the Zoom In and Zoom Out Buttons to the Toolbar

You can select the Add or Remove Buttons option to add or
remove several toolbar buttons at once.

Figure A-12 shows several commonly used buttons, such as the Link Tasks,
Zoom In, Zoom Out, and Indent buttons. Below the toolbar is the Entry bar,
which displays entries you make in the Entry table, located right below the
Entry text box. The Gantt chart calendar display appears on the right of the
split bar, which separates the Entry table and the Gantt chart. Use the Entry
table to enter WBS task information. The column to the left of the Task Name
column is the Indicators column. The Indicators column displays indicators or
symbols related to items associated with each task, such as task notes or hyper-
links to other files.

Tip

Toolbar Options

Zoom In
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Figure A-12. Project 2003 Main Screen Elements

Many features in Project 2003 are similar to features in other
Windows programs. For example, to collapse or expand tasks,
click the appropriate symbols to the left of the task name. To
access shortcut items, right-click in either the Entry table area or
the Gantt chart. Many of the Entry table operations in Project
2003 are very similar to operations in Excel. For example, to
adjust a column width, click and drag or double-click between
the column heading titles. 

If you select another view and want to return to the Gantt Chart view,
you can click the Gantt Chart button on the View Bar on the left of the
screen, or select View from the menu bar, and click Gantt Chart, as shown in
Figure A-13. If the Entry table on the left appears to be different, select View
from the menu bar, point to Table: Entry, and then click Entry to return to
the default Entry table view. 

Tip

Indicators

View Bar

Current
view

Split bar

Entry bar

Entry table

Link Tasks Zoom In Zoom Out Indent

Gantt chart calendar display
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Figure A-13. Project 2003 View Menu Options

Notice the split bar that separates the Entry table from the Gantt chart.
When you move the mouse over the split bar, your cursor changes to the resize
pointer. Clicking and dragging the split bar to the right reveals other task infor-
mation in the Entry table, including the Duration, Start date, Finish date,
Predecessors, and Resource Names columns.

Next, you’ll open a template file to explore more screen elements. Project
2003 comes with several template files, and you can also access templates on
Microsoft’s Web site. To open template files on your computer, click File on the
menu bar, and then click New. In the New Project task pane, click the “On my
computer” option under Templates, as shown in Figure A-14. You can also
access templates on Office Online or from your own Web sites.

Figure A-14. Opening a Template File

Access
templates
from various
locations

List of
recently
used
templates

View menu

Check
indicates
current view

Entry table
view

View Bar
selected

Split bar
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To access template files on your computer, you must do a full or
custom install of Project 2003. 

Figure A-15 shows results from searching for templates that contain the
word “Project” using the “Templates on Office Online” option. Note that the
templates found will vary based on the date of access.

Figure A-15. Finding Templates Using Office Online

To open a template file and adjust Project 2003 screen elements:

1. Open a template file. Click the Open button on the Standard tool-
bar, browse to find the file named PRJ03DPL.mpp that you copied
from the companion Web site for this text, and then double-click the
filename to open the file. This file provides a template for a project to
deploy Microsoft Office Project 2003 in a corporate environment.
Note that you are simply opening this file instead of accessing it from
the template options shown in Figure A-14.

2. View the Note. Move your mouse over the Notes icon in the
Indicators column and read its contents. It’s a good idea to provide a
short note describing the purpose of project files. Your screen should
resemble Figure A-16.

Help
?
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Figure A-16. The PRJ03DPL.mpp Template File

After you open template files, those filenames will appear on
your screen under the New from Template section. For exam-
ple, Figure A-14 shows that the template file for Software
Deployment was recently accessed on this user’s screen. You
can also see recently opened files from the File menu. 

3. Adjust the timescale. Click the Zoom Out button on the toolbar
three times to display the timescale in quarters. If you cannot find the
Zoom Out button, you can add it to the Standard toolbar by clicking
the Toolbar Options button, as described earlier.

4. Select Outline Level 2 to display WBS level 1 tasks. On the Standard tool-
bar, click the Show button’s list arrow , and then click Outline
Level 2, as shown in Figure A-17. Notice that only the level 1 WBS
items display in the Entry table after you select Outline Level 2, and
the timescale shows quarters. The black bars on the Gantt chart rep-
resent the summary tasks. This file included a summary task for the
entire project as the Outline Level 1 task. Recall from Chapter 5,
Project Scope Management that the entire project is normally
referred to as WBS level zero.

Help
?

Indicators
column

Notes icon
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Figure A-17. Viewing Summary Tasks Using the Show Button

5. Widen the Task Name column. Move the cursor over the right-column
gridline in the Task Name column heading until you see the resize
pointer , and then double-click the left mouse button to resize
the column width automatically to show all the text.

6. Move the split bar to reveal more Entry table columns. Move the split bar to
the right to reveal the entire Duration column. Your screen should
resemble Figure A-18.

Figure A-18. Adjusting Screen Elements

Collapse
symbol

Expand
symbol

Move split
bar to reveal
more columns

Double-click between column
headings to widen columns

Task Name column Show list arrow Summary tasks

Information Technology Project Management, Fourth Edition
Kathy Schwalbe

Copyright 2006 Thomson Course Technology. All rights reserved.

DO N
OT 

COPY



7. Expand a task. Click the expand symbol to the left of Task 2,
Envisioning, to see its subtasks. Click the collapse symbol to hide
its subtasks.

Project 2003 Views

In Project 2003, there are many ways to display project information. These dis-
plays are called views. To the left of the Entry table is the View Bar. Instead of
using commands on the View menu to change views, you can click buttons on
the View Bar. Several views discussed in the main text are on the default View
Bar: Gantt Chart, Network Diagram, Tracking Gantt, and Resource Graph.
Other views include Calendar, Task Usage, Resource Sheet, Resource Usage,
and an option to display More Views. These different views allow you to exam-
ine project information in different ways, which helps you analyze and under-
stand what is happening on your project.

To save screen space, you can hide the View Bar by selecting View from the
menu bar and deselecting View Bar. When the View Bar is not visible, a gray
line (or blue line in Windows XP) with the name of the current view appears
to the far left of the main screen. When you right-click this gray line, a shortcut
menu appears, which gives you quick access to the other views.

The View menu also provides access to different tables and reports that dis-
play information in a variety of ways. Some tables that you can access from the
View menu include Schedule, Cost, Tracking, and Earned Value. Some reports
you can access from the View menu include Overview, Current Activities,
Costs, Assignments, and Workload.

Some Project 2003 views, such as the Gantt Chart view, present a broad look at
the entire project, whereas others, such as the Form views, focus on specific pieces
of information about each task. Three main categories of views are available:

■ Graphical: A chart or graphical representation of data using bars, boxes,
lines, and images.

■ Task Sheet or Table: A spreadsheet-like representation of data in which
each task appears as a new row, and each piece of information about the
task is represented by a column. Different tables are applied to a task
sheet to display different kinds of information.

■ Form: A specific view of information for one task. Forms are used to focus
on the details of one task.

Table A-1 describes some of the predesigned views within each category that
Project 2003 provides to help you display the project or task information that
you need.
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Next, you will use the same Microsoft Office Project 2003 Deployment tem-
plate file (PRJ03DPL.mpp) to access and explore some of the views available in
Project 2003. As mentioned earlier, you can configure the toolbars and toolbar
buttons in different ways, as with other Office 2003 products. 

Table A-1: Common Project 2003 Views

CATEGORY OF VIEW VIEW NAME DESCRIPTION OF VIEW

Graphical Gantt Chart Standard format for displaying project schedule infor-
mation that lists project tasks and their corresponding
start and finish dates in a calendar format. Shows
each task as a horizontal bar with the length and
position corresponding to the timescale at the top of
the Gantt chart.

Network Schematic display of the logical relationships or 
Diagram sequencing of project activities. Shows each task as

a box with linking lines between tasks to show
sequencing. Critical tasks appear in red.

Task Sheet Entry Table Default table view showing columns for Task Name 
or Table and Duration. By revealing more of the Entry table,

you can enter start and end dates, predecessors, and
resource names.

Schedule Displays columns for Task Name, Start, Finish, Late 
Table Start, Late Finish, Free Slack, and Total Slack.

Cost Table Displays columns for Task Name, Fixed Cost, Fixed
Cost Accrual, Total Cost, Baseline, Variance, Actual,
and Remaining.

Tracking Displays columns for Task Name, Actual Start, Actual 
Table Finish, % Complete, Physical % Complete, Actual

Duration, Remaining Duration, Actual Cost, and
Actual Work.

Earned Displays columns for Task Name, BCWS, BCWP, 
Value ACWP, SV, CV, EAC, BAC, and VAC. See Chapter 7,

Project Cost Management, for descriptions of these
earned value terms.

Form Task Details Displays detailed information about a single task in 
Form one window.

Task Name Displays columns for Task Name, Resources, and 
Form Predecessors for a single task.
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To access and explore different views:

1. Show all subtasks. Click the Show button on the toolbar, and
then click All Subtasks.

2. Explore the Network Diagram view. Click the Network Diagram button
on the View Bar, and then click the Zoom Out button on the

toolbar three times. Your screen should resemble Figure A-19.

Figure A-19. Network Diagram View of Project 2003 Deployment File

3. Explore the Calendar view. Click the Calendar button on the View
Bar. Your screen should resemble Figure A-20.
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Figure A-20. Calendar View of Project 2003 Deployment File

4. Examine columns in the Entry table. Click the Gantt Chart button 
on the View Bar, and then move the split bar by moving your mouse
between the Entry table and Gantt chart until you see the resize
pointer . Click and drag your mouse to the right almost to the end
of the screen to reveal other columns in the Entry table. 

5. Examine the Table: Schedule view. Click View on the menu bar, move
your mouse to Table: Entry, and then click Schedule in the cascad-
ing menu to the right. Notice that the columns to the left of the Gantt
chart now display more detailed schedule information. 

6. Right-click the Select All button to access different table views. Move your
mouse to the Select All button to the left of the Task Name column
symbol, and then right-click with your mouse. A shortcut menu to
different table views displays, as shown in Figure A-21. Experiment
with other table views, then return to the Table: Entry view.

Information Technology Project Management, Fourth Edition
Kathy Schwalbe

Copyright 2006 Thomson Course Technology. All rights reserved.

DO N
OT 

COPY



Figure A-21. Changing Table Views

7. Explore the Reports feature. Click View on the menu bar, and then click
Reports. The Reports dialog box displays, as shown in Figure A-22.

Figure A-22. Reports Dialog Box

Select All button Schedule table view
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8. View the Project Summary report. Double-click Overview from the
Reports dialog box, and then double-click Project Summary in the
Overview Reports dialog box. Notice that the insertion point now
resembles a magnifying glass. Click inside the report to Zoom In or
Zoom Out. Click the Close button to close this report, and then
experiment with viewing other reports. You will use several reports
and other views throughout this appendix.

9. Close the Reports feature. Click Close to close the Reports dialog box
and return to the Gantt Chart view.

Project 2003 Filters

Project 2003 uses an underlying relational database to filter, sort, store, and dis-
play information. This database is compatible with Microsoft Access, and it is
relatively easy to import information from and export information to other
applications. Project 2003 is an Object Linking and Embedding for Databases
(OLE-DB) provider, meaning that it has low-level connectivity between multi-
ple types of data sources. For example, you can import or export data to other
applications such as Excel, Access, Oracle, and so on.

You can filter information by clicking the Filter text box list arrow, as shown
in Figure A-23. You can access more filter options by using the scroll bar.

Figure A-23. Filter List Options

Filtering project information is very useful. For example, if a project includes
hundreds of tasks, you might want to view only summary or milestone tasks to
get an overview of the project. To get this type of overview of a project, select the
Milestones or Summary Tasks filter from the Filter list. If you are concerned
about the schedule, you can select a filter that shows only tasks on the critical

Filter text box list arrow

Information Technology Project Management, Fourth Edition
Kathy Schwalbe

Copyright 2006 Thomson Course Technology. All rights reserved.

DO N
OT 

COPY



path. Other filters include Completed Tasks, Late/Overbudget Tasks, and Date
Range, which displays tasks based on dates you provide. As shown earlier, you
can also click the Show list arrow on the toolbar to display different levels in the
WBS quickly. For example, Outline Level 1 shows the highest-level items in the
WBS, Outline Level 2 shows the next level of detail in the WBS, and so on.

To explore Project 2003 filters:

1. Apply a filter to see only milestone tasks. From the Table: Entry view in
the Microsoft Office Project 2003 Deployment file, click the Toolbar
Options button on the toolbar, and then click the Filter list arrow,
as shown in Figure A-24.

Figure A-24. Using a Filter 

2. Filter to show specific tasks. Click Milestones in the list of filters. Your
screen should resemble Figure A-25. Recall from Chapter 6, Project
Time Management, that the black diamond symbol represents a mile-
stone, a significant event on a project.

Toolbar Options
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Figure A-25. Milestone Tasks Filter for Project 2003 Deployment File

3. Show summary tasks. Select All Tasks from the Filter list box to reveal
all the tasks in the WBS again. Click the Filter list arrow, scroll down
until you see Summary Tasks, and then click Summary Tasks. Now
only the summary tasks appear in the WBS. Experiment with other
outline levels and filters. 

4. Close the file. When you are finished reviewing the Project 2003
Deployment file, click Close from the File menu or click the Close
button. A dialog box appears asking if you want to save changes.
Click No. 

5. Exit Project 2003. Select Exit from the File menu or click the Close
button for Project 2003.

Now that you are familiar with Project 2003 main screen elements, views,
and filters, you will learn how to use Project 2003 to assist in project scope
management by creating a new project file, developing a WBS, and setting a
baseline.

Milestones filter applied

Gantt chart
only shows
milestones
and summary
tasks
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PROJECT SCOPE MANAGEMENT

Project scope management involves defining the work to perform to carry out
the project. To use Project 2003, you must first determine the scope of the
project. To begin determining the project’s scope, create a new file with the
project name and start date. Develop a list of tasks that need to be done to
carry out the project. This list of tasks becomes the work breakdown structure
(WBS; see Chapter 5). If you intend to track actual project information against
the initial plan, you must set a baseline. In this section, you will learn how to
create a new project file, develop a WBS, and set a baseline to help plan and
manage the Project Tracking Database project. To start, you will enter the
scope-related information.

In this section, you will go through several steps to create a
Project 2003 file named scope.mpp. If you want to download the
completed file to check your work or continue to the next sec-
tion, a copy of scope.mpp is available on the companion Web
site for this text or from your instructor. You should try to com-
plete an entire section of this appendix (project scope manage-
ment, project time management, and so on) in one sitting to
create the complete file. 

Creating a New Project File

To create a new project file:

1. Create a blank project. Open Project 2003, and close the Getting Started
pane and the following Tasks pane. A blank project file automatically
opens when you start Project 2003. The default filenames are
Project1, Project2, and so on. If Project 2003 is already open and you
want to open a new file, click the New button on the toolbar, as with
other Office programs.

2. Open the Project Information dialog box. Click Project on the menu
bar, and then click Project Information to display the Project
Information dialog box, as shown in Figure A-26. The Project
Information dialog box enables you to set dates for the project, select
the calendar to use, and view project statistics. The project start date
will default to today’s date. 

Tip
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Figure A-26. Project Information Dialog Box

3. Enter the project start date. In the Start date text box, enter 6/4/07.
Setting your project start date to 6/4/07 will ensure that your work
matches the results that appear in this appendix. Leave the Finish
date, Current date, and other information at the default settings.
Click OK.

Project 2003 uses American date formats. For example, 6/4/07
represents June 4, 2007. Be sure to enter dates in this format. 

4. Enter project properties. Click File on the menu bar, and then click
Properties. 

Any command that you click in the expanded menu is added
immediately to the personalized (short) version of the menu. If
you stop using a command for a while, Project 2003 stops show-
ing it on the short version of the menu. 

5. Enter project information. Type Project Tracking Database in the Title
text box, type Terry Dunlay in the Author text box, as shown in
Figure A-27, and then click OK. Note that you may have some default
information entered in the Project Properties dialog box, such as your
company’s name. Keep this file open for the next set of steps.

Tip
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Figure A-27. Project Properties Dialog Box

Developing a Work Breakdown Structure

Before using Project 2003, you must develop a work breakdown structure
(WBS) for your project. Developing a good WBS takes time, and it will make
entering tasks into the Entry table easier if you develop the WBS first. It is also
a good idea to establish milestones before entering tasks in Project 2003. See
Chapter 5, Project Scope Management, for more information on creating a
WBS and determining milestones. You will use the information in Table A-2 to
enter tasks for the Project Tracking Database project. Be aware that this exam-
ple is much shorter and simpler than most WBSs.

To develop a work breakdown structure and enter milestones for the
Project Tracking Database project:

1. Enter task names. Enter the twenty tasks in Table A-2 into the Task
Name column in the order shown. Do not worry about durations or
any other information at this time. Type the name of each task into
the Task Name column of the Entry table, beginning with the first
row. Press Enter or the down arrow key on your keyboard to move
to the next row.
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If you accidentally skip a task, highlight the task row and
select Insert from the menu bar, then select New Task, to
insert a blank row. To edit a task entry, click the text for that
task, click the Entry bar under the formatting toolbar, and
either type over the old text or edit the existing text. 

Entering tasks into Project 2003 and editing the information is
similar to entering and editing data in an Excel spreadsheet.
Project 2003, like Project 2002, includes a feature called a Smart
Tag, which appears, for example, when you delete a row. The
Smart Tag clarifies whether you want to delete the entire task or
only clear the contents of a cell. 

2. Move the split bar to reveal more columns. If necessary, move the split bar
to the right to reveal the entire Task Name and Duration columns. 

3. Adjust the Task Name column width, as needed. To make all the text display
in the Task Name column, move the mouse over the right-column
gridline in the Task Name column heading until you see the resize
pointer , then click the left mouse button and drag the line to the
right to make the column wider, or double-click to adjust the column
width automatically. 

Tip

Table A-2: Project Tracking Database Tasks

ORDER TASKS ORDER TASKS

1 Initiating 11 Design

2 Kickoff meeting 12 Implementation

3 Develop project charter 13 System implemented

4 Charter signed 14 Controlling

5 Planning 15 Report performance

6 Develop project plans 16 Control changes

7 Review project plans 17 Closing

8 Project plans approved 18 Prepare final project report

9 Executing 19 Present final project

10 Analysis 20 Project completed

Help
?
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This WBS separates tasks according to the project management process
groups of initiating, planning, executing, controlling, and closing. These tasks
will be the level 1 items in the WBS for this project. It is a good idea to include
all of these process groups, because there are important tasks that must be done
under each of them. Recall that the WBS should include all of the work
required for the project. In the Project Tracking Database WBS, the tasks will
purposefully be left at a high WBS level (level 2). You will create these levels, or
the WBS hierarchy, next when you create summary tasks. For a real project,
you would usually break the WBS into even more levels to provide more details
to describe all the work involved in the project. For example, analysis tasks for a
database project might be broken down further to include preparing entity rela-
tionship diagrams for the database and developing guidelines for the user inter-
face. Design tasks might be broken down to include preparing prototypes,
incorporating user feedback, entering data, and testing the database.
Implementation tasks might include more levels, such as installing new hard-
ware or software, training the users, fully documenting the system, and so on.

Creating Summary Tasks

After entering the WBS tasks listed in Table A-2 into the Entry table, the next
step is to show the WBS levels by creating summary tasks. The summary tasks
in this example are Tasks 1 (initiating), 5 (planning), 9 (executing), 14 (con-
trolling), and 17 (closing). You create summary tasks by highlighting and
indenting their respective subtasks.

To create the summary tasks:

1. Select lower-level or subtasks. Highlight Tasks 2 through 4 by clicking the
cell for Task 2 and dragging the mouse through the cells to Task 4.

2. Indent subtasks. Click the Indent button on the Formatting tool-
bar, so your screen resembles Figure A-28. After the subtasks (Tasks 2
through 4) are indented, notice that Task 1 automatically becomes
boldface, which indicates that it is a summary task. A collapse symbol

appears to the left of the new summary task name. Clicking the
collapse symbol will collapse the summary task and hide the subtasks
beneath it. When subtasks are hidden, an expand symbol appears
to the left of the summary task name. Clicking the expand symbol
will expand the summary task. Also, notice that the symbol for the
summary task on the Gantt chart has changed from a blue line to a
black line with arrows indicating the start and end dates.
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Figure A-28. Indenting Tasks to Create the WBS Hierarchy

3. Create other summary tasks and subtasks. Create subtasks and summary
tasks for Tasks 5, 9, 14, and 17 by following the same steps. Indent
Tasks 6 through 8 to make Task 5 a summary task. Indent Tasks 10
through 13 to make Task 9 a summary task. Indent Tasks 15 through
16 to make Task 14 a summary task. Indent Tasks 18 through 20 to
make Task 17 a summary task.

To change a task from a subtask to a summary task or to change
its level in the WBS, you can “outdent” the task. Click the cell of
the task or tasks you want to change, and then click the Outdent
button on the Formatting toolbar. Remember that the tasks
in Project 2003 should be entered in an appropriate WBS format
with several levels in the hierarchy. 

Numbering Tasks

Depending on how Project 2003 is set up on your computer, you may or may
not see numbers associated with tasks as you enter and indent them.

Tip

Expand or
collapse
symbols by
summary
tasks

Indent Summary task symbol
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To display automatic numbering of tasks, using the standard tabular
numbering system for a WBS:

1. Display the Options dialog box. Click Tools on the menu bar, and then
click Options. The Options dialog box opens.

2. Show outline numbers. Click the View tab, if necessary. Check Show
outline number in the “Outline options for Project1” section of
the View tab. Click OK to close the dialog box. Figure A-29 shows
the Options dialog box and resulting outline numbers applied to the
WBS tasks.

Figure A-29. Adding Outline Numbers

Saving Project Files With or Without a Baseline

An important part of project management is tracking performance against a
baseline, or approved plan. Project 2003, like Project 2002, does not prompt
you to save a file with or without a baseline each time you save it, as previous
versions did. The default is to save without a baseline. It is important to wait
until you are ready to save your file with a baseline, because Project 2003 will
show changes against a baseline. Because you are still developing your project
file for the Project Tracking Database project, you want to save the file without
a baseline. Later in this appendix, you will save the file with a baseline by
selecting Tools, Tracking, and then Set Baseline. You will then enter actual
information to compare planned and actual performance data.

Outline
numbers
show WBS
hierarchy

Show outline
number
check box
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To save a file without a baseline:

1. Save your file. Click File on the menu bar and then click Save, or click
the Save button on the Standard toolbar.

2. Enter a filename. In the Save As dialog box, type scope in the File
name text box. Save the file in your personal folder, on a floppy disk,
or in the C:\temp folder, depending on how your computer is set up.
Click Save. Your Project 2003 file should look like Figure A-30. (You
can adjust the timescale to show months by clicking Zoom In or
Zoom Out.)

If you want to download the Project 2003 file scope.mpp to
check your work or continue to the next section, a copy is avail-
able on the companion Web site for this text or from your
instructor.

Figure A-30. Project 2003 Scope File
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Project 2003 now includes the Visio WBS Chart Wizard. This wizard helps
you to create a graphical view of your WBS, similar to the samples provided in
Chapter 5. If you want to create a WBS in a chart format first and then import
it into Project 2003, you can use several add-in products that provide that
capability. Figure A-31 shows the Help information available from Project 2003
on creating a Visio WBS chart. 

Figure A-31. Help on Creating a Visio WBS Chart

To create a WBS using the Visio WBS Chart Wizard:

You must have Microsoft Visio 2000 or later installed on your
computer to use this wizard. If you do not have Visio installed,
skip the following steps. 

1. Show the analysis toolbar. Click View on the menu bar, select
Toolbars, and then click Analysis.

2. Open the wizard. Click Visio WBS Chart Wizard on the Analysis tool-
bar, and then click Launch Wizard.

3. View the wizard options. Click Next in Step 1 of the wizard, and then
review the options in Step 2, as shown in Figure A-32. Notice that you
can select which tasks or level of tasks you want to include, and include
a second display field. Select the second radio button, if needed, and
then set the outline level to 2. Uncheck the second Display Field option,
so your screen resembles Figure A-32.

Help
?
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Figure A-32. Visio WBS Chart Wizard - Step 2 of 3

4. Run the wizard. Click Next to go to Step 3, click Finish, and then click
OK. If you are prompted to automatically download and display the
links, click No.

5. Open the resulting file in Visio. Click the Visio button that should now
appear on your Windows 2000 or Windows XP Task Launch bar, and
then close the Organization Chart toolbar, if necessary. Your screen
should resemble Figure A-33, showing the WBS in Visio.

Figure A-33. WBS in Microsoft Visio
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6. Close Visio. Click the Close button, and then click No when prompted
to save the file to close Microsoft Visio.

7. Hide the Analysis toolbar. Click View on menu bar, select Toolbars,
and then click Analysis.

8. Save the file. Click File on the menu bar and then click Save, or click
the Save button on the Standard toolbar.

Now that you have finished entering all twenty tasks, created the summary
tasks and subtasks, set the options to show the standard WBS tabular number-
ing system, saved your file, and explored the Visio WBS Chart Wizard, you will
learn how to use the Project 2003 time management features. 

PROJECT TIME MANAGEMENT

Many people use Project 2003 for its time management features. The first step
in using these features, after entering the WBS for the project, is to enter dura-
tions for tasks or specific dates when tasks will occur. Entering durations or
specific dates will automatically update the Gantt chart. To use Project 2003 to
adjust schedules automatically and to do critical path analysis, you must also
enter task dependencies. After entering durations and task dependencies, you
can view the network diagram and critical path information. This section
describes how to use each of these time management features.

Entering Task Durations

When you enter a task, Project 2003 automatically assigns to it a default dura-
tion of one day, followed by a question mark. To change the default duration,
type a task’s estimated duration in the Duration column. If you are unsure of
an estimate and want to review it again later, enter a question mark after it.
For example, you could enter 5d? for a task with an estimated duration of five
days that you want to review later. You can then use the Tasks With Estimated
Durations filter to quickly see the tasks for which you need to review duration
estimates.

To indicate the length of a task’s duration, you must type both a number and
an appropriate duration symbol. If you type only a number, Project 2003 auto-
matically enters days as the duration unit. Duration unit symbols include:

■ d = days (default)

■ w = weeks

■ m = minutes

■ h = hours
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■ mo or mon = months

■ ed = elapsed days

■ ew = elapsed weeks

For example, to enter one week for a task duration, type 1w in the Duration
column. (You can also type wk, wks, week, or weeks, instead of just w.) To
enter two days for a task duration, type 2d in the Duration column. The default
unit is days, so if you enter 2 for the duration, it will be entered as 2 days. You
can also enter elapsed times in the Duration column. For example, 2ed means
two elapsed days, and 2ew means two elapsed weeks. You would use an
elapsed duration for a task like “Allow paint to dry.” The paint will dry in
exactly the same amount of time regardless of whether it is a workday, a week-
end, or a holiday.

If the Duration column is not visible, drag the split bar to the
right until the Duration column is in view. 

Entering time estimates or durations might seem like a straightforward
process. However, you must follow a few important procedures:

■ As you saw in the previous section, when you enter a task in the Task
Name column, 1 day? appears in the Duration column. The question
mark means that you are unsure of the duration or want to go back to it.
Be sure to enter the durations you want to appear.

■ Do not enter durations for summary tasks. Summary task durations are
calculated automatically, based on the subtasks. If you enter a duration for
a task and then make it a summary task, its duration will automatically
change to match the durations of its subtasks. Project 2003 will not allow
you to enter or change the duration of a summary task. Think of it as
entering durations for work packages, the lowest-level items in your
WBS. The other items are really the WBS hierarchy. Let Project 2003 do
the duration calculations for you.

■ To mark a task as a milestone, enter 0 for the duration. You can also mark
tasks that have a non-zero duration as milestones by checking the Mark
task as milestone option in the Task Information dialog box on the
Advanced tab. The milestone symbol for those tasks will appear at their
start date. Double-click a task to access the Task Information dialog box.

■ To enter recurring tasks, such as weekly meetings or monthly status
reports, select Recurring Task from the Insert menu. Enter the task name,
the duration, and when the task occurs. Project 2003 will automatically
insert appropriate subtasks based on the length of the project and the
number of tasks required for the recurring task. For example, if you enter
a recurring task for monthly review meetings that occur on the first day of

Tip
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every month for a twelve-month project, Project 2003 will enter a sum-
mary task for monthly review meetings and twelve subtasks—one meet-
ing for each month.

■ You can enter the exact start and finish dates for activities, instead of
entering durations. To enter start and finish dates, move the split bar to the
right to reveal the Start and Finish columns. Enter start and finish dates
only when those dates are certain. If you want task dates to adjust accord-
ing to any other task dates, do not enter exact start and finish dates.
Instead, you should enter a duration and then establish a dependency to
related tasks. The real scheduling power of Project 2003 comes from setting up
dependencies or relationships among tasks, as described in the next section.

■ Project 2003 uses a default calendar with standard workdays and hours.
Duration estimates will vary according to the calendar you use. For exam-
ple, entering 5d in the standard calendar may result in more than five days
on the Gantt chart if the time period includes Saturday or Sunday. You can
change specific working and nonworking days, or the entire project calen-
dar, by selecting Change Working Time from the Tools menu.

■ You often need to adjust the timescale on the Gantt chart to see your
project’s schedule in different time frames, such as weeks, months,
quarters, or years. You expand the timescale by clicking the Zoom Out
button. The Zoom In button collapses the timescale. You can also change
the format of the timescale by having three tiers instead of two or by
formatting dates differently by double-clicking the timescale section of
the Gantt chart.

Next, you will set task durations in your Project Tracking Database file
(scope.mpp), created in the previous section. If you did not create the file
named scope.mpp, you can download it from the companion Web site for this
text. You will create a new recurring task and enter its duration, and then you
will enter other task durations. First, create a new recurring task called Status
Reports above Task 15, Report Performance.

To create a new recurring task:

1. Insert a recurring task above Task 15, Report performance. Open scope.mpp,
if necessary, and then click Report performance (Task 15) in the
Task Name column to select that task. Click Insert on the menu bar,
and then click Recurring Task. The Recurring Task Information dia-
log box opens. 

2. Enter task and duration information for the recurring task. Type Status
Reports as the task title in the Task Name text box. Type 1h in the
Duration text box. Select the Weekly radio button under Recurrence
Pattern. Click the week on list arrow and select every from the list.
Select the Wednesday check box. In the Range of Recurrence section,
type 6/13/07 in the Start text box, click the End by radio button, and
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then type 10/31/07 in the End by text box. Click the End by list arrow
to see the calendar, as shown in Figure A-34. You can use the calendar
to enter the Start and End by dates. The new recurring task will appear
above Task 15, Report Performance, when you are finished.

You can also enter a number of occurrences instead of an End by
for a recurring task. You might need to adjust the End by date
after you enter all of your task durations and dependencies.
Remember that the date on your computer determines the date
listed as Today in the calendar.  

Figure A-34. Recurring Task Information Dialog Box

3. View the new summary task and its subtasks. Click OK. Project 2003
inserts a new Status Reports subtask in the Task Name column. Note
that this new subtask is boldface and has an expand symbol to the
left of the task name. Expand the new subtask by clicking to the
left of the words Status Reports. To collapse the recurring task, click
the collapse symbol .

4. Adjust column widths and the timescale. Notice the # signs that appear in
the Duration column for the Status Reports task. Like Excel, Project
2003 uses these symbols to denote that the column width needs to be
increased. With the recurring task expanded, increase the Task Name
column heading by moving the mouse to the right of the Task Name
column heading until you see a resize pointer . Double-click to
adjust the column width and display the entire task name. Move the
split bar to the right to reveal the entire Duration column, and then
increase the Duration column’s width by double-clicking to the right
of the Duration column heading. Click the Zoom Out button on
the toolbar three times to display the Gantt chart in quarters. Your
screen should resemble Figure A-35. Notice that the recurring task
appears on the appropriate dates on the Gantt chart.   
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Figure A-35. Expanding a Recurring Task

Use the information in Table A-3 to enter durations for the other tasks for
the Project Tracking Database project. The Project 2003 row number is shown
to the left of each task name in the table. Remember that you already entered a
duration for the recurring task. Also, remember that you should not enter dura-
tions for summary tasks. Durations for summary tasks are automatically calcu-
lated to match the durations and dependencies of subtasks, as described further
in the next section, “Establishing Task Dependencies.”

Table A-3: Durations for Project Tracking Database Tasks

TASK NUMBER/ROW TASK NAME DURATION

2 Kickoff meeting 2h

3 Develop project charter 10d

4 Charter signed 0d

6 Develop project plans 3w

7 Review project plans 4mo

8 Project plans approved 0d

10 Analysis 1mo

11 Design 2mo

12 Implementation 1mo

13 System implemented 0d

37 Report performance 5mo

38 Control changes 5mo

40 Prepare final project report 2w

41 Present final project 1w

42 Project completed 0d
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To enter task durations for the other tasks:

1. Enter the duration for Task 2. Click the Duration column for row 2,
Kickoff meeting, type 2h, and then press Enter.

2. Enter the duration for Task 3. In the Duration column for row 3,
Develop project charter, type 10d, then press Enter. You can also just
type 10, since d or days is the default duration.

3. Enter remaining task durations. Continue to enter the durations, using
information in Table A-3.

4. Save your file and name it. Click File on the menu bar, and then click
Save As. Enter time as the filename, and then save the file to the
desired location on your computer or network. Keep this file open for
the next set of steps. 

Establishing Task Dependencies

To use Project 2003 to adjust schedules automatically and to do critical path
analysis, you must determine the dependencies or relationships among tasks
(see Chapter 6, Project Time Management). Project 2003 provides three meth-
ods for creating task dependencies: using the Link Tasks button; using the
Predecessors column of the Entry table; or clicking and dragging the Gantt
chart symbols for tasks with dependencies.

To create dependencies using the Link Tasks button, highlight tasks that are
related and then click the Link Tasks button on the toolbar. For example, to
create a finish-to-start dependency between Task 1 and Task 2, click any cell in
row 1, drag down to row 2, and then click the Link Tasks button. The default
type of link is finish-to-start. In the Project Tracking Database example, all the
tasks use this default relationship. You will learn about other types of depen-
dencies later in this appendix.

Selecting tasks is similar to selecting cells in Microsoft Excel. To
select adjacent tasks, you can click and drag the mouse. You can
also click the first task, hold down the Shift key, and then click
the last task. To select nonadjacent tasks, hold down the Control
(Ctrl) key as you click tasks in order of their dependencies. 

When you use the Predecessors column of the Entry table to create depen-
dencies, you must manually enter the information. To create dependencies
manually, type the task row number of the preceding task in the Predecessors
column of the Entry table. For example, Task 3 in Table A-3 has Task 2 as a
predecessor, which can be entered in the Predecessors column, meaning that
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Task 3 cannot start until Task 2 is finished. To see the Predecessors column of
the Entry table, move the split bar to the right.

You can also create task dependencies by clicking the Gantt chart symbol for
a task and then dragging to the Gantt chart symbol for a task that succeeds it.
For example, you could click the Milestone symbol for Task 4, hold down
the left mouse button, and drag to the Task Bar symbol for Task 6 to create a
dependency, as shown in the Gantt chart in Figure A-36. Note the Finish-to-
Start Link dialog box that appears when you use this method.

Figure A-36. Creating Task Dependencies

Next, you will use information from Figure A-37 to enter the predecessors
for tasks as indicated. You will create some dependencies by manually typing
the predecessors in the Predecessors column, some by using the Link Tasks but-
ton, some by using the Gantt chart symbols, and the remaining dependencies
by using whichever method you prefer.

To link tasks or establish dependencies for the Project Tracking Database
project:

1. Display the Predecessors column in the Entry table. Move the split bar to
the right to reveal the Predecessors column in the time.mpp file.
Widen the Task Name or other columns, if needed.

2. Highlight the cell where you want to enter a predecessor, and then type the
task number for the preceding task. Click the Predecessors cell for
Task 3, type 2, and press Enter.

3. Enter predecessors for Task 4. Click the Predecessors cell for Task 4,
type 3, and press Enter. Notice that as you enter task dependencies,
the Gantt chart changes to reflect the new schedule.

Link task Predecessors column Gantt chart symbols
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4. Establish dependencies using the Link Tasks button. To link Tasks 10
through 13, click the task name for Task 10 in the Task Name column
and drag down through Task 13. Then, click the Link Tasks button

on the toolbar. Alternately, you can also click Edit on the menu bar,
and then click Link Tasks.

5. Create a dependency using Gantt chart symbols. Click the Milestone symbol
for Task 4 on the Gantt chart, hold down the left mouse button,

and drag to the Task Bar symbol for Task 6. (See Figure A-36 to see this
step in progress.)

6. Enter remaining dependencies. Link the other tasks by manually entering
the predecessors into the Predecessors column, or by using the Link
Tasks button, or clicking and dragging the Gantt chart symbols. You can
view the dependencies in Figure A-37. For example, Task 8 has Task 6 as
a predecessor, Task 10 has Task 8 as a predecessor, and so on. If you have
entered all data correctly, the project should end on 11/19/07. 

7. Adjust screen elements. Click View from the menu bar, select View Bar
to collapse the View Bar, and then drag the resize line between the
Indicator column and the Task Name column to the left to remove
the Indicator column, if needed. Click View on the menu bar, select
Toolbars, and then click Project Guide to hide the Project Guide tool-
bar. When you finish, your screen should resemble Figure A-37. Double-
check your screen to make sure you entered the dependencies correctly.

Figure A-37. Project Tracking Database File with Durations and Dependencies
Entered
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8. Preview and save your file. Click File on the menu bar, and then select
Print Preview, or click the Print Preview button on the
Standard toolbar. When you are finished, close the Print Preview and
save your file again by clicking the Save button on the Standard
toolbar. If you desire, print your file by clicking the Print button 
on the Standard toolbar, or by selecting Print from the File menu.
Keep the file open for the next set of steps. 

The entire Predecessors column must be visible in the Gantt
Chart view for it to show up in the Print Preview. Close the Print
Preview and move the split bar to reveal the column fully, and
then select Print Preview again. Also, check your timescale to
make sure you are not wasting paper by having a timescale too
detailed. You should not print your file until the Print Preview
displays the desired information. 

Changing Task Dependency Types and Adding Lead or
Lag Time

A task dependency or relationship describes how a task is related to the start
or finish of another task. Project 2003 allows for four task dependencies: finish-
to-start (FS), start-to-start (SS), finish-to-finish (FF), and start-to-finish (SF).
You can find detailed descriptions of these dependencies in Chapter 6, Project
Time Management. By using these dependencies effectively, you can modify
the critical path and shorten your project schedule. The most common type of
dependency is finish-to-start (FS). All of the dependencies in the Project
Tracking Database example are FS dependencies. However, sometimes you
need to establish other types of dependencies. This section describes how to
change task dependency types. It also explains how to add lead or lag times
between tasks. You will shorten the duration of the Project Tracking Database
project by adding lead time between some tasks.

To change a dependency type, open the Task Information dialog box for that
task by double-clicking the task name. On the Predecessors tab of the Task
Information dialog box, select a new dependency type from the Type column
list arrow.

Help
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The Predecessors tab also allows you to add lead or lag time to a depen-
dency. You can enter both lead and lag time using the Lag column on the
Predecessors tab. Lead time reflects an overlap between tasks that have a
dependency. For example, if Task B can start when its predecessor, Task A, is
half-finished, you can specify a finish-to-start dependency with a lead time of
50 percent for the successor task. Enter lead times as negative numbers. In this
example, enter –50% in the first cell of the Lag column. Adding lead times is
also called fast tracking and is one way to compress a project’s schedule (see
Chapter 6).

Lag time is the opposite of lead time—it is a time gap between tasks that
have a dependency. If you need a two-day delay between the finish of Task C
and the start of Task D, establish a finish-to-start dependency between Tasks C
and D and specify a two-day lag time. Enter lag time as a positive value. In this
example, type 2d in the Lag column.

In the Project Tracking Database example, notice that work on design tasks
does not begin until all the work on the analysis tasks has been completed (see
Rows 10 and 11 on the WBS), and work on implementation tasks does not
begin until all the work on the design tasks has been completed (see Rows 11
and 12 on the WBS). In reality, it is rare to wait until all of the analysis work is
complete before starting any design work, or to wait until all of the design work
is finished before starting any implementation work. It is also a good idea to add
some additional time, or a buffer, before crucial milestones, such as a system
being implemented. To create a more realistic schedule, add lead times to the
design and implementation tasks and lag time before the system implemented
milestone.

To add lead and lag times:

1. Open the Task Information dialog box for Task 11, Design. In the Task
Name column, double-click the text for Task 11, Design. The Task
Information dialog box opens. Click the Predecessors tab.

2. Enter lead time for Task 11. Type –10% in the Lag column, as shown in
Figure A-38. Click OK. You could also type a value such as –5d to
indicate a five-day overlap. In the resulting Gantt chart, notice that
the bar for this task has moved slightly to the left. Also, notice that
the project completion date has moved from 11/19 to 11/15.
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Figure A-38. Adding Lead or Lag Time to Task Dependencies

3. Enter lead time for Task 12. Double-click the text for Task 12,
Implementation, type –3d in the Lag column, and click OK. Notice
that the project now ends on 11/12 instead of 11/15.

4. Enter lag time for Task 13. Double-click the text for Task 13, System
Implemented, type 5d in the Lag column for this task, and click
OK. Move the split bar to the right, if necessary, to reveal the
Predecessors column. When you are finished, your screen should
resemble Figure A-39. Notice the slight overlap in the taskbars for
Tasks 10 and 11 and the short gap between the taskbars for Tasks
12 and 13. You can zoom in to see the gap more clearly. The proj-
ect completion date should be 11/19.
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Figure A-39. Schedule for Project Tracking Database File with Lead and 
Lag Times

5. Save your file. Click File on the menu bar, and then click Save. Or,
click the Save button on the Standard toolbar. Keep this file open
for the next set of steps. 

You can enter or modify lead or lag times directly in the
Predecessors column of the Entry table. Notice how the predeces-
sors appear for Tasks 11, 12, and 13. For example, the Predecessors
column for Task 11 shows 10FS-10%. This notation means that
Task 11 has a finish-to-start (FS) dependency with Task 10 and a 10
percent lead. You can enter lead or lag times to task dependen-
cies directly into the Predecessors column of the Entry table by
using this same format: task row number, followed by type of
dependency, followed by the amount of lead or lag. 

Gantt Charts

Project 2003 shows a Gantt chart as the default view to the right of the Entry
table. Gantt charts show the timescale for a project and all of its activities. In
Project 2003, dependencies between tasks are shown on the Gantt chart by the
arrows between tasks. Many Gantt charts, however, do not show any depen-
dencies. Instead, as you might recall, network diagrams or PERT charts are used
to show task dependencies. See Chapter 6 for more information about Gantt
charts and network diagrams. This section explains important information about
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Gantt charts and describes how to make critical path information more visible in
the Gantt Chart view.

You must follow a few important procedures when working with Gantt charts:

■ To adjust the timescale, click the Zoom Out button or the Zoom In but-
ton . Clicking these buttons automatically makes the dates on the Gantt
chart show more or less information. For example, if the timescale for the
Gantt chart is showing months and you click the Zoom Out button, the
timescale will adjust to show quarters. Clicking Zoom Out again will display
the timescale in years. Similarly, each time you click the Zoom In button,
the timescale changes to display more detailed time information— from
years to quarters, quarters to months, and months to weeks.

■ You can also adjust the timescale and access more formatting options by
selecting Timescale from the Format menu. Adjusting the timescale
enables you to see the entire Gantt chart on one screen and in the time
increments that you desire.

■ A Gantt Chart Wizard is available on the Format menu. This wizard helps
you adjust the format of the Gantt chart. For example, you can select an
option to display critical path information on the Gantt chart, and those
items on the critical path will automatically display using a red bar.

■ You can view a tracking Gantt chart by setting a baseline for your entire
project or for selected tasks and then entering actual durations for tasks.
The Tracking Gantt view displays two taskbars, one above the other, for
each task. One taskbar shows planned or baseline start and finish dates,
and the other taskbar shows actual start and finish dates. You will find a
sample tracking Gantt chart later in this appendix, after you enter actual
information for the Project Tracking Database project.

Because you have already created task dependencies, you can now find the
critical path for the Project Tracking Database project. You can view the critical
tasks by changing the color of those items on the critical path in the Task Name
column. You can also change the color of bars on the Gantt chart. Tasks on the
critical path will automatically be red in the Network Diagram view, as
described in the following section.

To make the text for the critical path tasks appear in red in the Entry
table and on the Gantt chart:

1. Open the Text Styles dialog box. Click Format on the menu bar, and
then click Text Styles. The Text Styles dialog box opens.

2. Change the critical tasks color option to red. Click the Item to Change list
arrow, and then select Critical Tasks. Click the Color list arrow, and
then select Red, as shown in Figure A-40. Click OK to accept the
changes to the text styles.
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Figure A-40. Text Styles Dialog Box Settings to Display Critical Tasks in Red

3. Open the Gantt Chart Wizard. Click Format on the menu bar and then
select Gantt Chart Wizard. Alternately, you can click the Gantt
Chart Wizard button on the Formatting toolbar. The Gantt Chart
Wizard opens. Click Next, and the next step of the wizard appears.

4. Select the Critical Path option. Click the Critical path radio button, as
shown in Figure A-41. Notice that the sample Gantt chart in the
Gantt Chart Wizard displays some bars in red, representing tasks on
the critical path. Click Finish to proceed to the next step in the Gantt
Chart Wizard.

Figure A-41. Gantt Chart Wizard Showing Critical Path Format
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5. Format the Gantt chart. Click Format It, and then click Exit Wizard.
Critical taskbars on the Gantt chart will now be red. Your screen
should resemble Figure A-39, but now task information and bars for
all the critical tasks are displayed in red.

6. Save your file without a baseline. Click File on the menu bar, and then
click Save. Or, click the Save button on the Standard toolbar to
save your file. Keep this file open for the next set of steps.

Network Diagrams

The network diagrams in Project 2003 use the precedence diagramming
method, with tasks displayed in rectangular boxes and relationships shown by
lines connecting the boxes. In the Network Diagram view, tasks on the critical
path are automatically shown in red.

To view the network diagram for the Project Tracking Database project:

1. View the network diagram. Click View on the menu bar, and then click
View Bar. Click the Network Diagram button on the View Bar
or select Network Diagram from the View menu.

2. Adjust the Network Diagram view. To see more tasks in the Network
Diagram view, click the Zoom Out button twice. You can also
use the scroll bars to see different parts of the network diagram.
Figure A-42 shows several of the tasks in the Project Tracking
Database network diagram. Note that milestone tasks, such as
Charter signed, appear as pointed rectangular boxes, while other
tasks appear as rectangles. Tasks on the critical path automatically
appear in red, while noncritical tasks appear in blue. Each task in the
network diagram also shows information such as the start and finish
dates, task ID, and duration. Move your mouse over any of the boxes
to see them in a larger view. A dashed line on a network diagram
represents a page break. You often need to change some of the
default settings for the Network Diagram view before printing it.
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Figure A-42. Network Diagram View

3. View the Help topic on rearranging network diagram boxes. Click the
Microsoft Project Help button on the Standard toolbar or press
F1 to display the Office Assistant. Type How do I rearrange the
network diagram? in the text box and then press Enter. Click the
resulting Help topic called Rearrange Network Diagram boxes.
Figure A-43 shows the resulting Project 2003 Help window. Note that
you can change several layout options for the network diagram, hide
fields, and manually position boxes. Close the Help window, and then
close the Search Results window.
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Figure A-43. Project 2003 Help Window for Rearranging the Network
Diagram Boxes

4. Return to Gantt Chart view. Click the Gantt Chart button on the
View Bar to return to Gantt Chart view. Alternately, you can select
Gantt Chart from the View menu on the menu bar. Keep this file
open for the next set of steps.

Some people create new Project 2003 files or add tasks to exist-
ing files in Network Diagram view instead of Gantt Chart view.
To add a new task or node in Network Diagram view, select New
Task from the Insert menu, or press the Insert key on your key-
board. Double-click the new node to add a task name and other
information. Create finish-to-start dependencies between tasks
in Network Diagram view by clicking the preceding node and
dragging to the succeeding node. To modify the type of depen-
dency and add lead or lag time, double-click the arrow between
the dependent nodes. 

Critical Path Analysis

Recall that the critical path is the path through the network diagram with no
slack or the least amount of slack; it represents the shortest possible time to
complete the project (see Chapter 6). If a task on the critical path takes longer
than planned, the project schedule will slip unless time is reduced on a task
later on the critical path. Sometimes you can shift resources between tasks to
help keep a project on schedule. Project 2003 has several views and reports to
help analyze critical path information.

Tip
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Two particularly useful features are the Schedule table view and the Critical
Tasks report. The Schedule table view shows the early and late start dates for each
task, the early and late finish dates for each task, and the free and total slack for
each task. This information shows how flexible the schedule is and helps in making
schedule compression decisions. The Critical Tasks report lists only tasks that are on
the critical path for the project. If meeting schedule deadlines is essential for a proj-
ect, project managers will want to monitor tasks on the critical path closely.

To access the Schedule table view and view the Critical Tasks report for
a file:

1. View the Schedule table. Right-click the Select All button to the left of
the Task Name column heading and select Schedule. Alternatively,
you can click View on the menu bar, point to Table: Entry, and
then click Schedule. The Schedule table replaces the Entry table to
the left of the Gantt chart.

2. Reveal all columns in the Schedule table. Move the split bar to the right
until you see the entire Schedule table. Your screen should resemble
Figure A-44. This view shows the start and finish (meaning the early
start and early finish) and late start and late finish dates for each task,
as well as free and total slack. Right-click the Select all button and
select Entry to return to the Entry table view.

Figure A-44. Schedule Table View

Select All button
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3. Open the Reports dialog box. Click View on the menu bar, and then
click Reports. Double-click Overview to open the Overview
Reports dialog box. Your screen should resemble Figure A-45.

Figure A-45. Accessing the Critical Tasks Report

4. Display the Critical Tasks report. Double-click Critical Tasks. A Critical
Tasks report as of today’s date is displayed.

5. Close the report and save your file. When you are finished examining the
Critical Tasks report, click Close. Click Close on the Reports dialog
box. Click the Save button on the Standard toolbar to save your
file. Close Project 2003 if you are not continuing to the next section.

If you want to download the completed time.mpp file to check
your work or continue to the next section, a copy is available on
the companion Web site for this text or from your instructor. 

Now that you have entered task durations, established task dependencies,
and reviewed the network diagram and critical path information, you are ready
to explore some of the Project 2003 cost management features. 

PROJECT COST MANAGEMENT

Many people do not use Project 2003 for cost management. Most organizations
have more established cost management software products and procedures in
place, and many people simply do not know how to use the cost features.
Using the cost features of Project 2003, however, makes it possible to integrate
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total project information more easily. This section offers brief instructions for
entering fixed and variable cost estimates and actual cost and time information
after establishing a baseline plan. It also explains how to use Project 2003 for
earned value management. More details on these features are available in
Project 2003 Help, online tutorials, or other books.

To complete the steps in this section, you need to download the
Project 2003 file resource.mpp from the companion Web site for
this book and save it on a floppy disk or with your other project
files on your hard drive.

Fixed and Variable Cost Estimates

The first step to using the cost features of Project 2003 is entering cost-related
information. You enter costs as fixed or variable based on per-use material
costs, or variable based on the type and amount of resources used. Costs
related to personnel are often a significant part of project costs.

Entering Fixed Costs in the Cost Table

The Cost table allows you to enter fixed costs related to each task. To access the
Cost table, right-click the Select All button and select Cost or select Table: Cost
from the View menu. Figure A-46 shows the resulting view for the Project
Tracking Database project using time.mpp. You can also assign a per-use cost to
a resource that represents materials or supplies and use it as a base for calculat-
ing the total materials or supplies cost of a task. See Project 2003 Help for
details on this feature.

Note
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Figure A-46. Cost Table View

Entering Human Resource Costs

Human resources represent a major part of the costs on many projects. By
defining and then assigning human resources and their related costs to tasks in
Project 2003, you can calculate human resource costs, track how people are
used, identify potential resource shortages that could force you to miss dead-
lines, and identify underutilized resources. It is often possible to shorten a proj-
ect’s schedule by reassigning underutilized resources. This section focuses on
entering human resource costs and assigning resources to tasks. The following
section describes other features of Project 2003 related to human resource
management.

There are several methods for entering resource information in Project 2003.
One of the easiest is to enter basic resource information in the Resource Sheet.
Access the Resource Sheet from the View Bar, or by selecting Resource Sheet
from the View menu. The Resource Sheet allows you to enter the resource
name, initials, resource group, maximum units, standard rate, overtime rate,
cost/use, accrual method, base calendar, and code. Entering data into the
Resource Sheet is similar to entering data into an Excel spreadsheet, and you
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can easily sort items by selecting Sort from the Project menu. In addition, you
can use the Filter list on the Formatting toolbar to filter resources. Once you
have established resources in the Resource Sheet, you can assign those
resources to tasks in the Entry table with the list arrow that appears when you
click a cell in the Resource Names column. The Resource Names column is the
last column of the Entry table. You can also use other methods for assigning
resources, as described below.

Next, you will use the Project 2003 file time.mpp, which you saved in the
preceding section, to assign resources to tasks. (If you did not save your file,
download it from the companion Web site for this text.) Assume that there are
four people working on the Project Tracking database project. Assume that the
only costs for this project are for these human resources: Kathy is the project
manager; John is the business analyst; Mary is the database analyst; and Chris
is an intern or trainee.

To enter basic information about each person into the Resource Sheet:

1. Display the Resource Sheet view. Open your Project 2003 file, time.mpp,
if necessary. Click the Resource Sheet button on the View Bar
(you may need to scroll to see it), or click View on the menu bar,
and then click Resource Sheet.

2. Enter resource information. Enter the information from Table A-4 into
the Resource Sheet. Type the information as shown and press the
Tab key to move to the next field. Notice that you are putting abbre-
viated job titles in the Initials column: PM stands for project manager;
BA stands for business analyst; DA stands for database analyst; and IN
stands for intern. When you type the standard and overtime rates,
you can just type 50, and Project 2003 will automatically enter
$50.00/hr. The standard and overtime rates entered are based on
hourly rates. You can also enter annual salaries by typing the annual
salary number followed by /y for “per year.” Leave the default values
for the other columns in the Resource Sheet as they are. Your screen
should resemble Figure A-47 when you are finished entering the
resource data.

Table A-4: Project Tracking Database Resource Data

RESOURCE NAME INITIALS GROUP STAND. RATE OVT. RATE

Kathy PM 1 $50.00/h $60.00/h

John BA 1 $40.00/h $50.00/h

Mary DA 1 $40.00/h $50.00/h

Chris IN 1 $20.00/h $25.00/h
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Figure A-47. Resource Sheet View with Resource Data Entered

If you know that some people will be available for a project only
part-time, enter their percentage of availability in the Max Units
column of the Resource Sheet. Project 2003 will then automati-
cally assign those people based on their maximum units. For
example, if someone can work only 25 percent of their time on a
project throughout most of the project, enter 25% in the Max
Units column for that person. When you enter that person as a
resource for a task, his or her default number of hours will be 25
percent of a standard eight-hour workday, or two hours per day. 

Adjusting Resource Costs

To make a resource cost adjustment, such as a raise, for a particular resource,
double-click the person’s name in the Resource Name column, select the Costs
tab in the Resource Information dialog box, and then enter the effective date
and raise percentage. You can also adjust other resource cost information, such
as standard and overtime rates.

To give the project manager a 10 percent raise starting 8/1/07:

1. Open the Resource Information dialog box. In Resource Sheet view,
double-click Kathy in the Resource Name column. The Resource
Information dialog box opens.

2. Enter an effective date for a raise. Select the Costs tab, and then select
tab A, if needed. Type 8/1/07 in the second cell in the Effective Date
column and press Enter. Alternately, click the list arrow in the sec-
ond cell and use the calendar that appears to enter the effective date.

3. Enter the raise percentage. Type 10% in the second cell for the Standard
Rate column, and then press Enter. The Resource Information screen
should resemble Figure A-48. Notice that Project 2003 calculated the
10% raise to be $55.00/h. Click OK.

Tip
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Figure A-48: Adjusting Resource Costs

Assigning Resources to Tasks

For Project 2003 to calculate resource costs, you must assign the appropriate
resources to tasks in your WBS. There are several methods for assigning
resources. The Resources column in the Entry table allows you to select
a resource using a list. You can, however, use this method to assign only
one resource to a task full-time. You often need to use other methods to
assign resources, such as the Assign Resources button on the Resource
Management toolbar or the Resource Cost window, to ensure that Project
2003 captures resource assignments as you intend them. Next, you will
use these three methods for assigning resources to the Project Tracking
Database project.

Assigning Resources Using the Entry Table

To assign resources using the Entry table:

1. Select the task to which you want to assign resources. Click the Gantt
Chart button on the View Bar. Click View on the menu bar, and
then click Table: Entry, if necessary, to return to the Entry table. 
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2. Reveal the Resource Names column of the Entry table. Move the split bar
to the right to reveal the entire Resource Names column in the
Entry table.

3. Select a resource from the Resource Names column. In the Resource Names
column, click the cell associated with Task 2, Kickoff meeting. Click
the cell’s list arrow, and then click Kathy to assign her to Task 2.
Notice that the resource choices are based on information that you
entered in the Resource Sheet. If you had not entered any resources,
you would not have a list arrow or any choices to select.

4. Try to select another resource for Task 2. Again, click the cell’s list
arrow in the Resource Names column for Task 2, click John, and
then press Enter. Notice that only John’s name appears in the
Resource Names column. You can assign only one resource to a task
using this method.

5. Clear the resource assignment. Right-click the Resource Names column
for Task 2, and then select Clear Contents to remove the resource
assignments.

Assigning Resources Using the Toolbar

To assign resources using the Resource Management toolbar:

1. Select the task to which you want to assign resources. Click the task
name for Task 2, Kickoff meeting, in the second row of the Task
Name column.

2. Open the Assign Resources dialog box. Click the Assign Resources
button on the Resource Management toolbar. (If the Assign
Resources button is not visible, click the Toolbar Options button
on the Resource Management toolbar, and then click the Assign
Resources button.) The Assign Resources dialog box, which lists the
names of the people assigned to the project, is displayed, as shown in
Figure A-49. This dialog box remains open while you move from task
to task to assign resources. Click the expand symbol to the left of
Resource list options. 
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Figure A-49. Assign Resources Dialog Box

3. Assign Kathy to Task 2. Click Kathy in the Resource Name column of
the Assign Resources dialog box, and then click Assign. Notice that
the duration estimate for Task 2 remains at 2 hours, and Kathy’s
name appears on the Gantt chart by the bar for Task 2.

4. Assign John to Task 2. Click John in the Resource Name column of the
Assign Resources dialog box, and then click Assign. The duration for
Task 2 changes to 1 hour, but you do not want this change to occur. Click
Close in the Assign Resources dialog box.

5. Clear the resource assignments. Right-click the Resource Names column
for Task 2, and then select Clear Contents to remove the resource
assignments.

6. Reenter the duration for Task 2. Type 2h in the Duration column for
Task 2 and press Enter.

Assigning Resources Using the Split Window and Resource
Cost View

Even though using the Assign Resources button seems simpler, it is often better
to use a split window and the Resource Cost view when assigning resources.
When you assign resources using the split view, the durations of tasks will not
automatically change when you assign more resources, and you have more
control over how you enter information. Project 2003 Help offers more infor-
mation on different options for resource assignment.
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To assign both Kathy and John to attend the two-hour kickoff meeting:

1. Split the window to reveal more information. Click Window on the menu
bar, and then click Split. The Gantt Chart view is displayed at the top
of the screen and a resource information table is displayed at the bot-
tom of the screen.

2. Open the Resource Cost window. Right-click anywhere in the bottom
window and select Resource Cost.

3. Assign Kathy to Task 2. Select Task 2, Kickoff meeting in the top win-
dow, and then click the first cell in the Resource Name column in
the Resource Cost window. Click the cell’s list arrow and select
Kathy. Press Enter.

4. Assign John to Task 2. Click the cell’s list arrow and select John.
Press Enter.

5. Enter the resource assignment and review the Gantt chart. Click OK in the
Resource Cost window. Your screen should resemble Figure A-50.
Notice that the duration for Task 2 is still two hours, and both Kathy
and John are assigned to that task 100%. You can also enter a differ-
ent percentage under the Units column if resources will not work 100
percent of their available time on a task. Note that the default settings
are that tasks are effort driven and the Task type is Fixed Units. You
will learn more about these settings later.

Figure A-50. Split Screen View for Entering Resource Information

Effort driven
check box

Task type
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6. Open the Resource Schedule window. Right-click anywhere in the lower
window and select Resource Schedule. Notice that Kathy and John
are assigned to Task 2 for two hours, as you intended. You can also
enter resource information using the Resource Schedule option.

7. Close the file and do not save it. Close the file, but do not save the
changes you made. Other resource information has been entered for
you in the Project 2003 file named resource.mpp, available on the
companion Web site for this text.

A copy of the Project 2003 file resource.mpp is available on the
companion Web site for this text or from your instructor. You
must use this file to continue the steps in the next section. 

As you can see, you must be careful when assigning resources. Project 2003
assumes that the durations of tasks are not fixed, but are effort-driven, and this
assumption can create some problems when you are assigning resources.
Figure A-51 shows the results of adding resources with different settings. The
first four task entries assume the task, Design, is effort-driven. When you
assign one resource to the Design task, John, the duration is one month. If you
later assign two resources, John and Mary, to that same task without changing
any settings, Project 2003 automatically adjusts the duration of that task to half
its original duration, or 0.5 months. If you change the task type to be Fixed
Duration and assign two resources, the duration remains at one month and
each resource is assigned 50 percent to the task. If you change the type to
Fixed Work and assign two resources, the duration is cut in half and the
resources are assigned full-time. The bottom part of Figure A-51 shows the
results when a task is not effort-driven or when you assign the Fixed Work task
type. You must be very careful when entering resource information to make
sure the task duration and work hours reflect what you want.

Help
?
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Figure A-51. Results of Adding Resources With Various Task Types

Viewing Project Cost Information

Once you enter resource information, Project 2003 automatically calculates
resource costs for the project. There are several ways to view project cost infor-
mation. You can view the Cost table to see cost information, or you can run
various cost reports. Next, you will view cost information for the Project
Tracking Database project.

To view cost information:

1. Open resource.mpp. Download resource.mpp from the companion
Web site for this text or get it from your instructor. Open the file. 

2. Open the Cost table. Right-click the Select All button and click Cost,
or click View on the menu bar, point to Table: Entry, and then click
Cost. The Cost table displays cost information and the Gantt chart.
Move the split bar to the right to reveal all of the columns. Your
screen should resemble Figure A-52. Note that by assigning
resources, costs have been automatically calculated for tasks. You
could also enter fixed costs for tasks in the cost table, but there are no
fixed costs associated with this project.

Fixed Work forces the
Effort Driven field to “yes”

Note the effects of type
on resource assignments
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Figure A-52. Cost Table for the Resource File

3. Open the Cost Reports dialog box. Click View on the menu bar, and
then click Reports. Double-click Costs to display the Cost Reports
dialog box.

4. Set the time units for the report. Click Cash Flow, if necessary, and then
click Edit. The Crosstab Report dialog box is displayed. Click the
Column list arrow and select Months, as shown in Figure A-53.
Click OK.
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Figure A-53. Crosstab Report Dialog Box

5. View the Cash Flow report. Click Select in the Cost Reports dialog box.
A Cash Flow report for the Project Tracking Database project appears,
as shown in Figure A-54. Click Close.

Figure A-54. Cash Flow Report
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6. View the Project Summary report. In the Reports dialog box, double-click
Overview, and then double-click Project Summary. A Project
Summary report for the Project Tracking Database project is dis-
played, listing information such as project baseline start and finish
dates; actual start and finish dates; summaries of duration, work
hours, and costs; as well as variance information. Since you have not
yet saved the file as a baseline, much of this information is blank in
the report. The Project Summary report provides a high-level
overview of a project. Click Close to close the report after reviewing
it. Click Close on the Reports dialog box. Keep this file open for the
next set of steps. 

You can edit many of the report formats in Project 2003. Instead
of double-clicking the report, highlight the desired report, and
then click Edit. 

The total estimated cost for this project, based on the information entered,
should be $49,774.35, as shown in the Cash Flow and Project Summary
reports. In the next section, you will save this data as a baseline plan and enter
actual information. 

Baseline Plan, Actual Costs, and Actual Times

Once you complete the initial process of creating a plan—entering tasks, estab-
lishing dependencies, assigning costs, and so on—you are ready to set a base-
line plan. By comparing the information in your baseline plan to an updated
plan during the course of the project, you can identify and solve problems.
After the project ends, you can use the baseline and actual information to plan
similar, future projects more accurately. To use Project 2003 to help control
projects, you must establish a baseline plan, enter actual costs, and enter actual
durations.

Establishing a Baseline Plan

An important part of project management is setting a baseline plan. If you plan
to compare actual information such as durations and costs, you must first save
the Project 2003 file as a baseline. The procedure involves selecting Tracking,
and then Save Baseline from the Tools menu. Before setting a baseline, you
must complete the baseline plan by entering time, cost, and human resources
information. Be careful not to save a baseline until you have completed the
baseline plan. If you do save a baseline before completing the baseline plan,
Project 2003 allows you to save up to ten baselines. You can then clear
unwanted baseline plans.

Tip
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Even though you can clear a baseline plan or save multiple baselines, it is a
good idea to save a separate, backup file of the original baseline for your project.
Enter actuals and save that information in the main file, but always keep a
backup baseline file without actuals. Keeping separate baseline and actual files
will allow you to return to the original file in case you ever need to use it again.

To rename resource.mpp and then save it as a baseline plan in Project 2003:

1. Save resource.mpp as a new file named baseline.mpp. Click File on the
menu bar, and then click Save As. Type baseline as the filename,
and then click Save. 

2. Open the Save Baseline dialog box. Click Tools on the menu bar, select
Tracking, and then click Save Baseline. The Save Baseline dialog
box is displayed. Click the Baseline list arrow to reveal multiple
baselines, as shown in Figure A-55. 

Figure A-55. Save Baseline Dialog Box Showing Ability to Save Multiple Baselines

3. Review the Save Baseline options, and save the entire project as a baseline.
If necessary, click the Save baseline radio button and the Entire
project radio button. Use the default option of the first Save baseline
name of just Baseline. These options should be the default settings in
Project 2003. Click OK.

Notice that there are several options in the Save Baseline dialog
box, as shown in Figure A-55. You can save the file as an interim
plan if you anticipate several versions of the plan. You can also
select the entire project or selected tasks when saving a baseline
or interim plan. As mentioned above, you can save up to ten
baselines with Project 2003. 

Tip
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Entering Actual Costs and Times

After you set the baseline plan, it is possible to track information on each of
the tasks as the project progresses. You can also adjust planned task information
for tasks still in the future. The Tracking table displays tracking information, and
the Tracking toolbar helps you enter this information. Figure A-56 describes each
button on the Tracking toolbar. The 100% button and the Update as Scheduled
button are the most commonly used buttons for entering actual information.
Note that the functions of these buttons have not changed from Project 2002
except that the Collaborate Toolbar button is no longer available. 

Figure A-56. Buttons on the Tracking Toolbar

To practice entering actual information, enter just a few changes to the base-
line. Assume that Tasks 1 through 8 were completed as planned, but that Task
10 took longer than planned.

BUTTON NAME DESCRIPTION

Project Statistics Provides summary information about the project baseline, the 
actual project start and finish dates, and overall project 
duration, costs, and work

Update as Scheduled Updates the selected tasks to indicate that actual dates, costs, 
and work match the scheduled dates, costs, and work

Reschedule Work Schedules the remaining duration for a task that is behind 
schedule so that it will continue from the status date

Add Progress Line Displays a progress line on the Gantt chart from a date that 
you select on the time scale

0% Complete Marks the selected tasks as 0% complete as of the status date 
(Actual date, work, and duration data is updated)

25% Complete Marks the selected tasks as 25% complete as of the status date
(Actual date, work, and duration data is updated)

50% Complete Marks the selected tasks as 50% complete as of the status date
(Actual date, work, and duration data is updated)

75% Complete Marks the selected tasks as 75% complete as of the status date
(Actual date, work, and duration data is updated)

100% Complete Marks the selected tasks as 100% complete as of the status 
date (Actual date, work, and duration data is updated)

Update Tasks Displays the Update Tasks dialog box for the selected tasks so 
that you can enter their percentages completed, actual 
durations, remaining durations, or actual start or finish dates

Bunin, Rachel, (2004) New Perspectives on Microsoft Office Project 2003, Introductory, Course
Technology (253).
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To enter actual information for tasks that were completed as planned:

1. Display the Tracking toolbar. Click View on the menu bar, select
Toolbars, and then click Tracking. Move the toolbar as desired.

2. Display the Tracking table. Right-click the Select All button, and then
click Tracking to see more information as you enter actual data.
Widen the Task Name column to see all of the text, and then move
the split bar to reveal all the columns in the Tracking table.

3. Mark Tasks 1 though 8 as 100% complete. Click the Task Name for Task 1,
Initiating, and drag down through Task 8 to highlight the first eight
tasks. Click the 100% Complete button on the Tracking toolbar.
The columns with dates, durations, and cost information should now
contain data instead of the default values, such as NA or 0. The %
Comp column should display 100%. Adjust column widths if needed.
Your screen should resemble Figure A-57.

Figure A-57. Tracking Table Information

4. Enter actual completion dates for Task 10. Click the Task Name for Task 10,
Analysis, and then click the Update Tasks button on the far
right side of the Tracking toolbar. The Update Tasks dialog box
opens. For Task 10, enter the Actual Start date as 7/11/07 and the
Actual Finish date as 8/16/07, as shown in Figure A-58. Click OK.

Tracking
toolbar
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Figure A-58. Update Tasks Dialog Box

5. Display the Indicators column. Click Insert on the menu bar, and then
click Column. The Column Definition dialog box opens. Click the
Field name list arrow, select Indicators, and then click OK. The
Indicators column is displayed, showing a check mark by com-
pleted tasks.

6. Review changes in the Gantt chart. Move the split bar to the left to reveal
more of the Gantt chart. Notice that the Gantt chart bars for com-
pleted tasks have changed. Gantt chart bars for completed tasks
appear with a black line drawn through the middle.

You can hide the Indicators column by dragging the right border
of the column heading to the left. 

You can also view actual and baseline schedule information more clearly
with the Tracking Gantt view. See Chapter 6 for descriptions of the symbols on
a Tracking Gantt chart.

To display the Tracking Gantt chart:

1. View the Tracking Gantt chart. Click View on the menu bar, and then
click Tracking Gantt. Alternatively, you can click the Tracking
Gantt button on the View Bar, if it is displayed. Use the horizontal
scroll bar in the Gantt chart window, if necessary, to see symbols on
the Tracking Gantt chart.

Tip
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2. Display Gantt chart information in months. Click Zoom Out twice to
display information in months. Your screen should resemble Figure
A-59. (The Tracking toolbar was turned off in this figure to display
the entire schedule). Notice that the delay in this one task on the crit-
ical path has caused the planned completion date for the entire proj-
ect to slip. A good project manager would take corrective action to
make up for this lost time or renegotiate the completion date.

Figure A-59. Tracking Gantt Chart View

3. Save your file as a new file named mytracking.mpp. Click File on the
menu bar, and then click Save As. Name the file mytracking, and
then click Save.

Notice the additional information available on the Tracking Gantt chart.
Completed tasks have 100% by their symbols on the Tracking Gantt chart.
Tasks that have not started yet display 0%. Tasks in progress, such as Task 9,

Notice the
analysis task
started late
and took
longer than
planned to
complete

This one
delay could
cause the
project
completion
date to slip
unless
corrective
action is
taken
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show the percentage of the work completed (31% in this example). Also, note
that the project completion date has moved to 11/29 since several tasks
depended on the completion of Task 10, which took longer than planned.
Recall from Chapter 6 that a white diamond represents a slipped milestone.
Viewing the Tracking Gantt chart allows you to easily see your schedule
progress against the baseline plan.

After you have entered some actuals, you can review earned value informa-
tion for the initiating tasks of this project.

Earned Value Management

Earned value management (see Chapter 7, Project Cost Management) is an
important project management technique for measuring project performance.
Because you have entered actual information for the initiating tasks in the
Project Tracking Database project, you can now view earned value information
in Project 2003.

To view earned value information:

1. View the Earned Value table. Open tracking.mpp, which you down-
loaded from the companion Web site. Click View on the menu bar,
point to Table: Entry, and then select More Tables. The More
Tables dialog box opens. Double-click Earned Value.

2. Display all the Earned Value table columns. Move the split bar to the
right to reveal all of the columns. Note that the Earned Value table
includes columns for each earned value term described in Chapter 7.
Also note that the EAC (Estimate at Completion) is higher than the
BAC (Budget at Completion) starting with Task 9, where the task
took longer than planned to complete (Figure A-60). Task 9 shows a
VAC (Variance at Completion) of ($2,772.00), meaning the project is
projected to cost $2,772 more than planned at completion at that
point in time. Remember that not all of the actual information has
been entered yet.
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Figure A-60. Earned Value Table 

Project 2003 uses earned value terms from the 1996 PMBOK®

Guide. The PMBOK® Guides 2000 and 2004 use simpler acronyms
for earned value terms. See Chapter 7 for explanations of all the
earned value terms. 

3. Save and close the file. Click the Save button on the Standard toolbar,
and then close the tracking.mpp file.

If you want to check your work or continue to the next section,
copies of the files baseline.mpp and tracking.mpp are available
on the companion Web site for this text or from your instructor. 

Further information on earned value is available from Project 2003 Help or
in Chapter 7, Project Cost Management. To create an earned value chart, you
must export data from Project 2003 into Excel. There are also add-in products
you can use with Project 2003 to do more with earned value information.
Consult Project 2003 Help and Microsoft’s Web site for Project 2003
(www.microsoft.com/project) for more details.

Help
?

Help
?
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Now that you have entered and analyzed various project cost information,
you will examine some of the human resource management features of
Project 2003.

PROJECT HUMAN RESOURCE MANAGEMENT

In the project cost management section, you learned how to enter resource
information into Project 2003 and how to assign resources to tasks. Two other
helpful human resource features include resource calendars and histograms. In
addition, it is important to know how to use Project 2003 to assist in resource
leveling.

Resource Calendars

When you created the Project Tracking Database file, you used the standard
Project 2003 calendar. This calendar assumes that standard working hours are
Monday through Friday, from 8:00 a.m. to 5:00 p.m., with an hour for lunch
starting at noon. Rather than using this standard calendar, you can create a dif-
ferent calendar that takes into account each project’s unique requirements. You
can create a new calendar by using the Tasks pane or by changing the working
time under the Tools menu.

To create a new base calendar:

1. Open a new file. Click the New button on the Standard toolbar to
open a new Project 2003 file. The Tasks pane opens on the left side of
your screen.

2. Use the Tasks pane to create a new calendar. Click Define general
working times in the Tasks pane. A calendar wizard appears, as
shown in Figure A-61.
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Figure A-61. Using the Tasks Pane to Change Working Time

If the Tasks pane does not appear on your screen, click View on
the menu bar, select Toolbars, and then click Project Guide to see
the Project Guide toolbar. Click the Tasks list arrow, and then
click Define general working times.

3. Make changes to the calendar using the wizard. Click Save and go to
Step 2 at the lower part of the Project Working Times pane, select
the check box for Saturday to make it a working day, and then click
the I want to adjust the working hours shown for one or more
days of the week radio button. Scroll down to read the instructions
for adjusting working hours, and make changes as desired. Click
through the remaining steps to close the wizard.

4. Create a new base calendar. Click Tools on the menu bar, and then click
Change Working Time. The Change Working Time dialog box opens.

Help
?

Project Guide
Toolbar

Calendar
wizard
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5. Name the new base calendar. In the Change Working Time dialog box,
click New. The Create New Base Calendar dialog box opens. Click
the Create new base calendar radio button, type Mine as the
name of the new calendar in the Name text box, and then click OK.
Click OK to close the Change Working Time dialog box. 

You can use this new calendar for the whole project, or you can assign it to
specific resources on the project.

To assign the new calendar to the whole project:

1. Open the Project Information dialog box. Click Project on the menu bar,
and then click Project Information. The Project Information dialog
box opens.

2. Select a new calendar. Click the Calendar list arrow to display a list of
available calendars. Select your new calendar named Mine from this
list, and then click OK.

To assign a specific calendar to a specific resource:

1. Assign a new calendar. Click View on the menu bar, and then click
Resource Sheet. Type Me in the Resource Name column, press
Enter, and then select the word Me.

2. Select the calendar. Click the Base Calendar cell for that resource
name. If the Base Calendar column is not visible, click the horizontal
scroll bar to view more columns. Click the Base Calendar list arrow,
and then select Mine.

3. Block off vacation time. Double-click the resource name Me to display the
Resource Information dialog box, and then click the Working Time
tab. You can block off vacation time for people by selecting the appro-
priate days on the calendar and marking them as nonworking days, as
shown in Figure A-62. Close the Resource Information dialog box.

4. Close the file without saving it. Click File on the menu bar, and then
click Close. Click No when you are prompted to save the file.
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Figure A-62. Blocking Off Vacation Time

Resource Histograms

A resource histogram is a type of chart that shows the number of resources
assigned to a project over time (see Chapter 9, Project Human Resource
Management). A histogram by individual shows whether a person is over- or
underallocated during certain periods. To view histograms in Project 2003,
select Resource Graph from the View Bar or select Resource Graph from the
View menu. The Resource Graph helps you see which resources are overallo-
cated, by how much, and when. It also shows you the percentage of capacity
each resource is scheduled to work, so you can reallocate resources, if neces-
sary, to meet the needs of the project.

To view resource histograms for the Project Tracking Database project:

1. View the Resource Graph. Open the baseline.mpp file, and open the
View Bar, if necessary. Click the Resource Graph button on the
View Bar. If you cannot see the Resource Graph button, you may
need to click the up or down arrows on the View Bar. Alternatively,
you can click View on the menu bar, and then click Resource
Graph. A histogram for Kathy appears, as shown in Figure A-63.
Notice that the screen is divided into two sections. The left pane
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displays a person’s name and the right pane displays a resource his-
togram for that person. You may need to click the right scroll bar to
get the histogram to appear on your screen. Notice that Kathy is
overallocated slightly in the month of June, since the column for that
month goes above the 100% line.

Figure A-63. Resource Histogram View

2. Adjust the histogram’s timescale. Click Zoom Out or Zoom In , if
necessary, to adjust the timescale for the histogram so that it appears
in quarters and then months, as shown in Figure A-63.

3. View the next resource’s histogram. Click the right scroll arrow at the bot-
tom of the resource name pane on the left side of the screen. The
resource histogram for the next person appears. View the resource his-
tograms for all four people, and then go back to the first one for Kathy.

Notice that Kathy’s histogram has a partially red bar in June 2007. This red
portion of the bar means that she has been overallocated during that month.
The percentages at the bottom of each bar show the percentage each resource
is assigned to work. For example, Kathy is scheduled to work 107% of her
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available time in June, 62% of her available time in July, and so on. Project
2003 has two tools that enable you to see more details about resource overallo-
cation: the Resource Usage view and the Resource Management toolbar.

To see more details about an overallocated resource using the Resource
Usage view:

1. Display the Resource Usage view. Click the Resource Usage button 
from the View Bar or click View on the menu bar, and then click
Resource Usage.

2. Adjust the information displayed. On the right side of the screen, click
the right scroll arrow to display the hours Kathy is assigned to
work each day, starting on June 3rd. You may also need to click the
scroll down arrow to see all of Kathy’s hours. If you need to adjust
the timescale to display weeks, click Zoom Out or Zoom In. When
you are finished, your screen should resemble Figure A-64.

Figure A-64. Resource Usage View
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3. Examine overallocation information. Notice that Kathy’s name appears in
red, as does the value 5.57h in the column for Monday. Although Kathy
is not scheduled to work more than eight hours on Monday, some of the
tasks were entered as hours, and Project 2003 assumes those hours start
as soon as possible, thus causing the scheduling conflict. You’ll remove
the conflict using hour by hour leveling later in this section.

To learn more about an overallocated resource, you can also use the
Resource Management toolbar for resource allocation.

To see more resource allocation information:

1. View the Resource Management toolbar. Click View on the menu bar,
select Toolbars, and then click Resource Management. The
Resource Management toolbar displays below the Formatting toolbar.

2. Select the Resource Allocation view. Click the Resource Allocation View
button on the Resource Management toolbar. The Resource
Allocation view appears, showing the Resource Usage view at the top
of the screen and the Gantt Chart view at the bottom of the screen.
Figure A-65 shows this view with Kathy’s information highlighted.

Figure A-65. Resource Allocation View
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3. Close the file, but do not save any changes. Click File on the menu bar,
and then click Close. Click No when you are prompted to save
changes.

The Resource Allocation view can help you identify the source of a resource
overallocation. It is not obvious that Kathy has an overallocation the first day
of the project because she is only assigned to work a total of 5.57 hours. The
problem in this case is that she is assigned to several tasks that day that were
entered with durations of hours, and Project 2003 assumes each of those tasks
starts as soon as possible, thus resulting in the overallocation on an hourly
basis. You could ignore this problem or fix it with resource leveling, as shown
in the next section. By using the scroll bar, you can view information for other
resources. If you scroll down to look at Mary’s resource allocation information
and scroll to the right to reveal August and September, you can see that over-
lapping the design and implementation tasks may have caused another overal-
location problem. To fix the problem, you can have Mary work overtime,
assign another resource to help, or reschedule the implementation task to
reduce the overlap. You can also see if resource leveling, as described in the
next section, will help solve the problem.

Resource Leveling

Resource leveling is a technique for resolving resource conflicts by delaying
tasks. Resource leveling also creates a smoother distribution of resource usage.
You can find detailed information on resource leveling in Chapter 9, Project
Human Resource Management, and in Project 2003 Help.

To use resource leveling:

1. Reopen the baseline file. Click the Open button on the Standard
toolbar, navigate to baseline.mpp, and open it. Right-click the
Select All button and click Entry. Move the split bar to see more of
the Gantt chart. Notice that the project completion date is 11/19/07.

2. Open the Resource Leveling dialog box. Click Tools on the menu bar, and
then click Level Resources. The Resource Leveling dialog box
opens, as shown in Figure A-66. Uncheck the Level only within
available slack option, if necessary.
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Figure A-66. Resource Leveling Dialog Box

3. Level the file and review the date changes. Click the Level Now button.
In this example, resource leveling moved the project completion date
from 11/19 to 11/22, as shown on the Gantt chart milestone symbol
for Task 42, Project completed.

4. View Kathy’s Resource Graph again. Click the Resource Graph button
on the View Bar. If necessary, use the scroll bar in the resource

histogram pane to display June 2007. Notice that Kathy is still overal-
located in June 2007.

5. Level using the Hour by Hour option. Click Tools on the menu bar, and
then click Level Resources. Change the basis for leveling from Day
by Day to Hour by Hour, click the Level Now button, keep the
default option of Entire pool in the Level Now dialog box, and then
click OK. Notice that Kathy’s overallocation disappears. Click the
right scroll arrow in the resource name pane twice to reveal informa-
tion about Mary. Remember that the left pane displays different
resources, and the right pane reveals the resource histogram over
time. Mary’s overallocations are also gone, because of this resource
leveling.

6. View the Gantt chart again. Click the Gantt Chart button on the
View Bar and move the split bar to review the Gantt chart, if neces-
sary. The project completion date has been moved back to 11/26
because of the resource leveling.

Uncheck Level
only within
available slack,
if needed
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7. View the Leveling Gantt chart. Click View on the menu bar, click More
Views, and then double-click Leveling Gantt. Click the Zoom Out
button , if necessary, to adjust the timescale to show quarters and
months, and scroll to the right in the Gantt chart to reach June 2007.
Your screen should resemble Figure A-67. Project 2003 adds a green
bar to the Gantt chart to show leveled tasks. 

Figure A-67. Leveling Gantt Chart View

8. Save the file as level.mpp. Click File on the menu bar, click Save As,
type level as the filename, and then click Save. Close the file. 

If you want to undo the leveling, immediately click the Undo
button on the Standard toolbar. Alternatively, you can
return to the Resource Leveling dialog box, and click the Clear
Leveling button. 

If you want to check your work, a copy of level.mpp is available
on the companion Web site for this text or from your instructor. 

Help
?

Tip
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Consult the Project 2003 Help feature and use the key word “level” for more
information on resource leveling. Also, be careful when setting options for this
feature, so that the software adjusts resources only when it should. For exam-
ple, the end date for the Project Tracking Database project was pushed back
because you set the leveling options to allow the dates to slip. In this case, the
project manager might prefer to ask her team to work a little overtime to
remain on schedule.

Now that you have learned how to change resource calendars, view
resource histograms, and level resources, you are ready to learn how to use
Project 2003 to assist in project communications management.

PROJECT COMMUNICATIONS MANAGEMENT

Project 2003 can help you generate, collect, disseminate, store, and report proj-
ect information. There are many different tables, views, and reports to aid in
project communications, as you have seen in the previous sections. This section
highlights some common reports and views. It also describes how to use tem-
plates and insert hyperlinks from Project 2003 into other project documents,
how to save Project 2003 files as Web pages, and how to use Project 2003 in a
workgroup setting.

Common Reports and Views
To use Project 2003 to enhance project communications, it is important to

know when to use the many different ways to collect, view, and display project
information. Table A-5 provides a brief summary of Project 2003 features and
their functions, which will help you understand when to use which feature.
Examples of most of these features are provided as figures in this appendix.

You can see from Table A-5 that many different reports are available in
Project 2003. The overview reports provide summary information that top
management might want to see, such as a project summary or a report of mile-
stone tasks. Current activities reports help project managers stay abreast of and
control project activities. The reports of unstarted tasks and slipping tasks alert
project managers to problem areas. Cost reports provide information related to
the cash flow for the project, budget information, overbudget items, and
earned value management. 

Assignment reports help the entire project team by providing different views
of who is doing what on a project. You can see who is overallocated by running
the Overallocated Resources report or by viewing the two workload reports.
You can also create custom reports based on any project information you have
entered into Project 2003.
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Using Templates and Inserting Hyperlinks and Comments

Chapter 10, Project Communications Management, and several other chapters
provide examples of templates that you can use to improve project communica-
tions. Because it is often difficult to create good project plans, some organizations,

Table A-5: Functions of Project 2003 Features

FEATURE FUNCTION

Gantt Chart view, Entry table Enter basic task information.

Network Diagram view View task dependencies and critical path graphically.

Schedule table View schedule information in a tabular form.

Cost table Enter fixed costs or view cost information.

Resource Sheet view Enter resource information.

Resource Information and Assign resources to tasks.
Gantt Chart split view

Save Baseline Save project baseline plan.

Tracking toolbar Enter actual information.

Earned Value table View earned value information.

Resource Graph View resource allocation.

Resource Usage View detailed resource usage.

Resource Management View resource usage and Gantt chart to find 
toolbar overallocation problems.

Resource Leveling Level resources.

Overview Reports View project summary, top-level tasks, critical tasks,
milestones, working days.

Current Activities Reports View unstarted tasks, tasks starting soon, tasks in
progress, completed tasks, should have started tasks,
slipping tasks.

Cost Reports View cash flow, budget, overbudget tasks, overbudget
resources, earned value.

Assignment Reports View who does what, who does what when, to-do list,
overallocated resources.

Workload Reports View task usage, resource usage.

Custom Reports Allow customization of each type of report.

Save as Web page Save files as HTML documents.

Insert Hyperlink Insert hyperlinks to other files or Web sites.
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such as Northwest Airlines, Microsoft, and various government agencies, keep a
repository of sample Project 2003 files. As shown earlier in this appendix, Project
2003 includes several template files, and you can also access several templates
online. You must load the template files when installing Project 2003 or access
templates via the Internet.

To access the Project 2003 templates:

1. Open the New Project task pane. Start Project 2003, if necessary, click
File on the menu bar, and then click New to display the New Project
task pane, as shown in Figure A-68.

Figure A-68. Opening Templates

2. Open the Templates dialog box. Click the On my computer link below
the Templates section in the New Project task pane. The Templates
dialog box is displayed. Click the Project Templates tab, as shown
in Figure A-69. As you can see, there are many templates available.
You can also access additional templates from the Templates on
Office Online link from the New Project task pane, from other Web
sites, or from your own organization.

Templates
section

New Project
task pane
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Figure A-69. Project Templates on My Computer

If you do not have any templates loaded on your computer, you
will not see the files displayed in Figure A-69. You must load the
template files when installing Project 2003.

3. Open the Microsoft Office Templates Gallery. Click Cancel in the
Templates dialog box, and then click the Templates on Office
Online link in the New Project task pane. The resulting screen
should resemble Figure A-70. Experiment with searching for various
template files.

Help
?
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Figure A-70. Microsoft Office Online Web Site

4. Close your browser and the open Project file. Click the Close button on
your browser and then close the file in Project 2003.

Using templates can help you prepare your project files, but be careful to
address the unique needs of your project and organization. For example, even
though the Home Move template file can provide guidance in preparing a
Project 2003 file for a specific home move project, you need to tailor the file for
your particular situation and schedule. You can also create your own Project 2003
templates by saving your file as a template using the Save As option from the File
menu. Simply change the Save As Type option to Template. Project 2003 then
gives the file an .mpt extension (Microsoft Project Template) to identify the file as
a template.

In addition to using templates for Project 2003 files, it is helpful to use
templates for other project documents and insert hyperlinks to them from
Project 2003. For example, your organization might have templates for meeting
agendas, project charters, status reports, and project plans. See Appendix D and
the companion Web site for examples of other template files. Next, you will
create hyperlinks to some template files created in other applications.

To insert a hyperlink within a Project 2003 file:

1. Display the Entry table. Open the baseline.mpp file. Right-click the
Select All button and click Entry to return to the Entry table view.

Enter search
information
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2. Select the task in which you want to insert a hyperlink. Click the Task
Name for Task 2, Kickoff meeting.

3. Open the Insert Hyperlink dialog box. Click Insert on the menu bar, and
then click Hyperlink. Alternatively, you can right-click the task
name and select Hyperlink. The Insert Hyperlink dialog box opens,
as shown in Figure A-71. You may have different folders visible based
on your computer’s directory structure.

Figure A-71. Insert Hyperlink Dialog Box

4. Enter the filename of the hyperlink file. Click the Browse for File button
to browse for the kickoffmeeting.doc file you downloaded from the

companion Web site for this text. Double-click kickoffmeeting.doc,
and then click OK.

5. Reveal the Indicators column. Click Insert on the menu bar, and then
click Column. Click the Field Name list arrow, select Indicators,
and then click OK. A Hyperlink button appears in the Indicators
column to the left of the Task Name for Task 2. Move your mouse
over the hyperlink button until the mouse pointer changes to the
Hand symbol to reveal the name of the hyperlinked file.

Clicking the Hyperlink button in the Indicators column will automatically
open the hyperlinked file. Using hyperlinks is a good way to keep all project
documents organized.

It is also a good idea to insert notes or comments into Project 2003 files to
provide more information on specific tasks.
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To insert a note for Task 3:

1. Open the Task Information dialog box for Task 3. Double-click the Task
Name for Task 3, Develop project charter. Click the Notes tab.

2. Enter your note text. Type The charter was developed as a joint
effort. in the Notes text box, as shown in Figure A-72.

Figure A-72. Task Information Dialog Box Notes Tab

3. See the resulting Notes icon. Click OK to enter the note. The Notes icon
appears in the Indicators column next to Task 3.

4. Open the note. Double-click the Notes icon in the Indicators column
for Task 3 to view the note, and then click OK.

5. Close the file without saving it. Click File on the menu bar, and then
click Close. Click No when you are prompted to save the file.

Saving Files as Web Pages

Many organizations use the Web to disseminate information to employees and
to communicate with customers. Project 2003 includes a feature that enables
you to save project information as a Web page. As with most Microsoft applica-
tions, this feature in Project 2003 is available by selecting Save As Web Page
from the File menu. You can create Web pages in several standard formats,
including Compare to Baseline, Cost Data By Task, Earned Value Information,
Top Level Tasks List, a “Who Does What” Report, and more. You can also
design your own formats for information to be saved as Web pages.
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To save project information as a Web page:

1. Open the Save As dialog box for Web pages. Open baseline.mpp. Click
File on the menu bar, and then click Save As Web Page.

2. Name the Web page file. Type taskinfo in the File name text box as the
new filename, select the location where you’ll save the file, and then
click Save. The Export Wizard dialog box appears. Click Next to go to
the next step of the Export Wizard, click the option to Use existing
map, and then click Next, so your screen resembles Figure A-73.

Figure A-73. Export Wizard — Map Selection Dialog Box 

3. Select the import/export map. Click Default task information from the
import/export map list, and then click Finish. Project 2003 saves an
HTML version of task information from baseline.mpp. The name of
the new Web page is taskinfo.html.

To see the new Web page, you must open the new HTML file you created.

To open the taskinfo.html file:

1. Open Windows Explorer. Click the Start button on the taskbar, point to
Programs (or All Programs in Windows XP), point to Accessories,
and then click Windows Explorer. Navigate your folders to find the
taskinfo.html file. You can also use other methods to open Windows
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Explorer or use My Computer to find the desired file. Alternatively,
start your Web browser, and use the Open Page feature from the File
menu to open the file.

2. Open the taskinfo.html file in your Web browser. Double-click
taskinfo.html to open it in your Web browser. The file extension for
the file may not appear, depending on your settings. Figure A-74
shows part of the taskinfo.html file in Microsoft Internet Explorer.

Figure A-74. Default Task Information HTML File

3. Close the taskinfo.html and baseline.mpp files. Click Close to close your
browser, and then go back to your Project 2003 window and close
the baseline.mpp file without saving it.

There are several ways to change or customize the standard HTML documents
in Project 2003. The Export Wizard allows you to change formats for existing
maps, and you can also create your own map. Consult the Project 2003 Help
topic “HTML” to find more information on HTML features of Project 2003 and
saving your files as Web pages.
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Saving project information as Web pages includes text and numerical infor-
mation, but not graphic information. You can create Web displays of graphic
views, such as Gantt charts or network diagrams, but the process often requires
knowledge of how to include images in Web pages.

Using the Copy Picture to Office Wizard

The Copy Picture to Office Wizard is a new feature in Project 2003 that helps
you easily create and copy graphical images. After answering a few questions
in the wizard, you can quickly display project data as a static picture in Office
applications, including PowerPoint, Word, and Visio. You can access this wizard
on the Analysis toolbar.

To use the Copy Picture to Office Wizard:

1. Prepare the file you want to copy. Open baseline.mpp. Drag the split bar
to the left so that only the entire Task Name column is showing. Click
the collapse symbol for Task 1, Initiating. You should be able to
see the entire Gantt chart on your screen.

2. View the Analysis Toolbar. Click View on the menu bar, select
Toolbars, and then click Analysis to display the Analysis toolbar.

3. Open the Copy Picture to Office Wizard. Click the Copy Picture to Office
Wizard button on the Analysis toolbar. Click Next at each step of
the wizard until you reach Step 4. You have now accepted the default
settings to copy the entire picture of the screen to PowerPoint. Click
Finish, and then click Close when the wizard is complete. Your
screen should resemble Figure A-75. The wizard has created a picture
of your screen in Project 2003 and copied it into PowerPoint.
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Figure A-75. Copy Picture to Office Wizard Results in PowerPoint

4. Close all open windows. Click the Close button on any open windows.
You do not need to save any of the open files.

As you can see, Project 2003 is a very powerful tool. If used properly, it can
greatly help users successfully manage projects.

DISCUSSION QUESTIONS

1. What are some new features of Project 2003 Standard and how do they
differ from previous versions of Microsoft Project?

2. How do you use Project 2003 to create a WBS hierarchy?

3. Summarize how you use Project 2003 to assist in time management. How
do you enter durations, link tasks, and view critical path information?

4. How can Project 2003 assist you in project cost management? How do
you enter fixed costs? How do you enter resources and assign them to
tasks? How can you view earned value information?

5. Briefly describe how to change resource calendars, view resource his-
tograms, and level resources.
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6. Summarize different ways to communicate information with Project
2003. How do you link to other files from within your Project 2003 file?
How can you use templates and share information on the Web? How can
you copy pictures into other applications?

SUGGESTED READINGS

1. Bunin, Rachel. New Perspectives on Microsoft Office Project 2003, Introductory.
Boston: Course Technology (2004).

This book walks you through step-by-step tutorials on how to use
Project 2003 on one continuous running case. It includes six tutorials on
planning a project, creating a project schedule, communicating project
information, assigning resources and costs, tracking progress and
closing a project, and sharing information across projects, applications,
and the World Wide Web. There are review activities and several cases
for each chapter. There are also supporting files and other information
on the publisher’s Web site at www.course.com. You can also run an
interactive tutorial of Project 2002 from www.scsite.com/selabs.

2. Marmel, Elaine. Microsoft Office Project 2003 Bible, Hungry Minds, Inc. (2003).

This comprehensive text (960 pages) includes detailed information on
how to use Project 2003. It also includes a CD-ROM with an evaluation
copy of Project, add-on tools, and sample cases.

3. Pyron, Tim et al. Special Edition: Using Microsoft Office Project 2003, Que
Publishing (2004).

This text includes detailed coverage of Project 2003. It includes 1248
pages of text and additional information on Que’s Web site. The
companion CD-ROM contains all the examples developed for the book, a
third-party software library, and Web resources. Tim Pyron is a Microsoft
Project consultant, trainer, and editor of Woody’s Project Watch, a free
newsletter for Project users (www.woodyswatch.com/project).

4. Stover, Teresa S. Microsoft Office Project 2003 Inside Out. Microsoft Press (2003).

This text includes 1152 pages of text and a CD-ROM that contains a
trial version of Microsoft Office Project 2003 Standard Edition,
Microsoft resources and demos, a computer dictionary, and information
about third-party utilities and tools.

EXERCISES

The more you practice using the different features of Project 2003, the more
quickly you will master the application and be able to use it to manage proj-
ects. This section includes exercises based on three examples of information
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technology projects that could benefit from using Project 2003 to assist in proj-
ect scope, time, cost, human resource, and communications management. It
also includes an exercise you can use to apply Project 2003 on a real project.
There are simpler exercises that use Project 2003 at the end of several other
chapters in this text. You can also re-create several screen shots in this text to
practice your skills, or you can open and then make slight changes to template
files or the files that come with this text.

Exercise A-1: Web Site Development

A nonprofit organization would like you to lead a Web site development proj-
ect for them. The organization has Internet access that includes space on a Web
server, but has no experience developing Web pages or Web sites. In addition
to creating their Web site, they would like you to train two people on their staff
to do simple Web page updates. The organization wants their Web site to
include the following basic information, as a minimum: description of the orga-
nization (mission, history, and recent events), list of services, and contact infor-
mation. They want the Web site to include graphics (photographs and other
images) and have an attractive, easy-to-use layout.

1. Project Scope Management

Create a WBS for this project and enter the tasks in Project 2003. Create
milestones and summary tasks. Assume that some of the project manage-
ment tasks you need to do are similar to tasks from the Project Tracking
Database project. Some of the specific analysis, design, and implementa-
tion tasks will be to:

a. Collect information on the organization in hardcopy and digital form
(brochures, reports, organization charts, photographs, and so on).

b. Research Web sites of similar organizations.

c. Collect detailed information about the customer’s design preferences
and access to space on a Web server.

d. Develop a template for the customer to review (background color for
all pages, position of navigation buttons, layout of text and images,
typography, including basic text font and display type, and so on).

e. Create a site map or hierarchy chart showing the flow of Web pages.

f. Digitize the photographs and find other images for the Web pages; digi-
tize hard-copy text.

g. Create the individual Web pages for the site.

h. Test the pages and the site.

i. Implement the Web site on the customer’s Web server.

j. Get customer feedback.

k. Incorporate changes.
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l. Create training materials for the customer on how to update the
Web pages.

m.Train the customer’s staff on updating the Web pages.

2. Project Time Management

a. Enter realistic durations for each task, and then link the tasks as appro-
priate. Be sure that all tasks are linked (in some fashion) to the start and
end of the project. Assume that you have four months to complete the
entire project. (Hint: Use the Project Tracking Database as an example.)

b. Print the Gantt Chart view and Network Diagram view for the project.

c. Print the Schedule table to see key dates and slack times for each task.

3. Project Cost Management

a. Assume that you have three people working on the project, and each
of them would charge $20 per hour. Enter this information in the
Resource Sheet.

b. Estimate that each person will spend an average of about five hours per
week for the four-month period. Assign resources to the tasks, and try
to make the final cost in line with this estimate.

c. Print the budget report for your project.

4. Project Human Resource Management

a. Assume that one project team member will be unavailable (due to
vacation) for two weeks in the middle of the project. Make adjustments
to accommodate this vacation so that the schedule does not slip and the
costs do not change. Document the changes from the original plan and
the new plan.

b. Use the Resource Usage view to see each person’s work each month.
Print a copy of the Resource Usage view.

5. Project Communications Management

a. Print a Gantt chart for this project. Use a timescale that enables the
chart to fit on one page. Then use the Copy Picture to Office Wizard to
show the same Gantt chart in PowerPoint.

b. Print a “To-do List” report for each team member.

c. Create a “Who Does What Report” HTML document. Print it from your
Web browser.

Exercise A-2: Software Training Program

ABC Company has 50,000 employees in its headquarters. The company wants to
increase employee productivity by setting up an internal software applications
training program for its employees. The training program will teach employees
how to use software programs such as Windows, Word, Excel, PowerPoint,
Access, and Project 2003. Courses will be offered in the evenings and on
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Saturdays and will be taught by qualified volunteer employees. The instructors
will be paid $40 per hour. In the past, various departments sent employees to
courses offered by local vendors during company time. In contrast to local ven-
dors’ programs, this internal training program should save the company money
on training as well as make its people more productive. The Human Resources
department will manage the program, and any employee can take the courses.
Employees will receive a certificate for completing courses, and a copy of the cer-
tificate will be put in their personnel files. The company has decided to use off-
the-shelf training materials, but is not sure which vendor’s materials to use. The
company needs to set up a training classroom, survey employees on what
courses they want to take, find qualified volunteer instructors, and start offering
courses. The company wants to offer the first courses within six months. One
person from Human Resources is assigned full-time to manage this project, and
top management has pledged its support of the project.

1. Project Scope Management

Create a WBS for this project and enter the tasks in Project 2003. Create
milestones and summary tasks. Assume that some of the project manage-
ment tasks you need to do are similar to tasks from the Project Tracking
Database example. Some of the tasks specific to this project will be to:

a. Review off-the-shelf training materials from three major vendors and
decide which materials to use.

b. Negotiate a contract with the selected vendor for their materials.

c. Develop communications information about this new training program.
Disseminate the information via department meetings, e-mail, the com-
pany’s intranet, and flyers to all employees.

d. Create a survey to determine the number and type of courses needed
and employees’ preferred times for taking courses.

e. Administer the survey.

f. Solicit qualified volunteers to teach the courses.

g. Review resumes, interview candidates for teaching the courses, and
develop a list of preferred instructors.

h. Coordinate with the Facilities department to build two classrooms with
twenty personal computers in each, a teacher station, and an overhead
projection system (assume that the Facilities department will manage
this part of the project).

i. Schedule courses.

j. Develop a fair system for signing up for classes.

k. Develop a course evaluation form to assess the usefulness of each
course and the instructor’s teaching ability.

l. Offer classes.

2. Project Time Management
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a. Enter realistic durations for each task and then link appropriate tasks.
Be sure that all tasks are linked in some fashion to the start and end of
the project. Use the Project Tracking Database as an example. Assume
that you have six months to complete the entire project.

b. Print the Gantt Chart view and Network Diagram view for the project.

c. Print the Schedule table to see key dates and slack times for each task.

3. Project Cost Management

a. Assume that you have four people from various departments available
part-time to support the full-time Human Resources person, Terry, on
the project. Assume that Terry’s hourly rate is $40. Two people from
the Information Technology department will each spend up to 25 per-
cent of their time supporting the project. Their hourly rate is $50. One
person from the Marketing department is available 25 percent of the
time at $40 per hour, and one person from Corporate is available 30
percent of the time at $35 per hour. Enter this information about time
and hourly wages into the Resource Sheet. Assume that the cost to
build the two classrooms will be $100,000, and enter it as a fixed cost.

b. Using your best judgment, assign resources to the tasks. 

c. View the Resource Graphs for each person. If anyone is overallocated,
make adjustments.

d. Print the budget report for the project.

4. Project Human Resource Management

a. Assume that the Marketing person will be unavailable for one week,
two months into the project, and for another week, four months into
the project. Make adjustments to accommodate this unavailability, so
the schedule does not slip and costs do not change. Document the
changes from the original plan and the new plan.

b. Add to each resource a 5 percent raise that starts three months into the
project. Print a new budget report.

c. Use the Resource Usage view to see each person’s work each month.
Print a copy.

5. Project Communications Management

a. Print a Gantt chart for this project. Use a timescale that enables the
chart to fit on one page. Then use the Copy Picture to Office Wizard to
show the same Gantt chart in PowerPoint.

b. Print a “To-do List” report for each team member.

c. Create an HTML document using the “Default task information” map.
Print it from your Web browser.
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Exercise A-3: Project Tracking Database

Expand the Project Tracking Database example. Assume that XYZ Company
wants to create a history of project information, and the Project Tracking
Database example is the best format for this type of history. The company
wants to track information on twenty past and current projects and wants the
database to be able to handle one hundred projects total. It wants to track the
following project information:

■ Project name

■ Sponsor name

■ Sponsor department

■ Type of project

■ Project description

■ Project manager

■ Team members

■ Date project was proposed

■ Date project was approved or denied

■ Initial cost estimate

■ Initial time estimate

■ Dates of milestones (for example, project approval, funding approval,
project completion)

■ Actual cost

■ Actual time

■ Location of project files

1. Project Scope Management

Open scope.mpp and add more detail to Executing tasks, using the infor-
mation in Table A-6.
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2. Project Time Management

a. Enter realistic durations for each task, and then link appropriate tasks.
Make the additional tasks fit the time estimate: 20 days for analysis
tasks, 30 days for design tasks, and 20 days for implementation tasks.
Assume that all of the executing tasks have a total duration of 70 days.
Do not overlap analysis, design, and implementation tasks.

b. Print the Gantt Chart view and Network Diagram view for the project.

c. Print the Schedule table to see key dates and slack times for each task.

3. Project Cost Management

a. Use the resource and cost information provided in resource.mpp. 

Table A-6: Company XYZ Project Tracking Database Executing Tasks

ANALYSIS TASKS DESIGN TASKS IMPLEMENTATION TASKS

Collect list of 20 projects Gather detailed requirements for Enter project data
desired outputs from the database

Gather information on Create fully attributed, Test database
projects normalized data model

Define draft Create list of edit rules for fields, Make adjustments, 
requirements determine default values, develop as needed

queries, and determine formats 
for reports

Create entity relationship Develop list of queries required Conduct user testing
diagram for database for database

Create sample entry Review design information with Make adjustments based 
screen customer on user testing

Create sample report Make adjustments to design Create online Help, user 
based on customer feedback manual, and other

documentation

Develop simple Create full table structure in Train users on the 
prototype of database database prototype system

Review prototype with Create data input screens
customer

Make adjustments based Write queries
on customer feedback

Create reports

Create main screen

Review new prototype with 
customer
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b. Assign resources to the new tasks. Try to make the final cost about the
same as that shown in the Project Tracking Database example: about
$50,000.

c. Print the budget report for the project.

4. Project Human Resources Management

a. Two months after the project begins, give everyone on the team a
10 percent raise. Document the increase in costs that these raises cause.

b. Use the Resource Usage view to see each person’s work each month.
Print a copy of the Resource Usage view.

5. Project Communications Management

a. Print a Gantt chart for this project. Use a timescale that enables the
chart to fit on one page. Then use the Copy Picture to Office Wizard to
show the same Gantt chart in PowerPoint.

b. Print a “Top-Level Tasks” report.

c. Create a “Cost Data by Task” HTML document. Print it from your Web
browser.

Exercise A-4: Real Project Application

If you are doing a group project as part of your class or for a project at work,
use Project 2003 to create a detailed file describing the work you plan to do.
Enter a sufficient WBS, estimate task durations, link tasks, enter resources and
costs, assign resources, and so on. Then save your file as a baseline and track
your progress. View earned value information when you are about halfway
done with the project or course. Export the earned value information into
Excel and create an earned value chart. Continue tracking your progress until
the project or course is finished. Print your Gantt chart, Resource Sheet, Project
Summary report, and relevant information. In addition, write a two- to three-
page paper describing your experience. What did you learn about Project 2003
from this exercise? What did you learn about managing a project? How do you
think Project 2003 helps in managing a project? You may also want to inter-
view people who use Project 2003 and ask them about their experiences and
suggestions.

ADDITIONAL RUNNING CASES

Review the additional running cases provided in Appendix C. Several questions
involve using Project 2003.
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